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WARNINGS AND PRECAUTIONS

READ ALL PRODUCT MANUALS AND CONSULT WITH BECKMAN COULTER-TRAINED PERSONNEL BEFORE ATTEMPTING 
TO OPERATE INSTRUMENT. DO NOT ATTEMPT TO PERFORM ANY PROCEDURE BEFORE CAREFULLY READING ALL 
INSTRUCTIONS. ALWAYS FOLLOW PRODUCT LABELING AND MANUFACTURER’S RECOMMENDATIONS. IF IN DOUBT AS 
TO HOW TO PROCEED IN ANY SITUATION, CONTACT YOUR BECKMAN COULTER REPRESENTATIVE.

BECKMAN COULTER, INC. URGES ITS CUSTOMERS TO COMPLY WITH ALL NATIONAL HEALTH AND SAFETY 
STANDARDS SUCH AS THE USE OF BARRIER PROTECTION. THIS MAY INCLUDE, BUT IT IS NOT LIMITED TO, 
PROTECTIVE EYEWEAR, GLOVES, AND SUITABLE LABORATORY ATTIRE WHEN OPERATING OR MAINTAINING THIS OR 
ANY OTHER AUTOMATED LABORATORY ANALYZER.

HAZARDS AND OPERATIONAL PRECAUTIONS AND LIMITATIONS

WARNINGS, CAUTIONS, and IMPORTANTS alert you as follows:

WARNING - Can cause injury.
CAUTION - Can cause damage to the instrument.

IMPORTANT - Can cause misleading results.

WARNING  Risk of operator injury if:

 r All doors, covers and panels are not closed and secured in place prior to and during instrument operation.
 r The integrity of safety interlocks and sensors is compromised.
 r Instrument alarms and error messages are not acknowledged and acted upon.
 r You contact moving parts.
 r You mishandle broken parts.
 r Doors, covers and panels are not opened, closed, removed and/or replaced with care.
 r Improper tools are used for troubleshooting. 

To avoid injury:

 r Keep doors, covers and panels closed and secured in place while the instrument is in use.
 r Take full advantage of the safety features of the instrument. Do not defeat safety interlocks and sensors.
 r Acknowledge and act upon instrument alarms and error messages.
 r Keep away from moving parts.
 r Report any broken parts to your Beckman Coulter Representative.
 r Open/remove and close/replace doors, covers and panels with care.
 r Use the proper tools when troubleshooting.

CAUTION  System integrity might be compromised and operational failures might occur if:

 r This equipment is used in a manner other than specified. Operate the instrument as instructed in the Product Manuals.
 r You introduce software that is not authorized by Beckman Coulter into your computer. Only operate your system’s 

computer with software authorized by Beckman Coulter.
 r You install software that is not an original copyrighted version. Only use software that is an original copyrighted 

version to prevent virus contamination.

IMPORTANT  If you purchased this product from anyone other than Beckman Coulter or an authorized Beckman Coulter 
distributor, and, if it is not presently under a Beckman Coulter service maintenance agreement, Beckman Coulter cannot 
guarantee that the product is fitted with the most current mandatory engineering revisions or that you will receive the most 
current information bulletins concerning the product. If you purchased this product from a third party and would like 
further information concerning this topic, call your Beckman Coulter Representative.



REVISION STATUS

Initial Issue, 1/96
SYSTEM II Software, Version 1.0. Initial issue for customer distribution.

Issue B, 12/98
Complete revision. SYSTEM II Software, Version 3.0. Includes new quality control features, 
patient report export feature, and user-defined run time reports.

Issue C, 6/03
Changes were made to change the company name from Coulter Corporation to Beckman 
Coulter Inc.

Issue CA, 09/10
Updates were made to the company corporate address.

Note: Changes that are part of the most recent revision are indicated in text by a bar in the
margin of the amended page.

This document applies to the latest software listed and higher versions. When a subsequent software version 
changes the information in this document, a new issue will be released to the Beckman Coulter website.  For 
labeling updates, go to www.beckmancoulter.com and download the most recent manual or system help for 
your instrument.
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INTRODUCTION

This introductory section contains the following topics:

 r Using your COULTER EPICS XL and XL-MCL Flow Cytometer manuals

 r About this Manual

 r Conventions

 r Icons.

USING YOUR XL AND XL-MCL FLOW CYTOMETER MANUALS
Use the Reference manual for in-depth information on the principles of flow cytometry, 
information about what your instrument does, the methods it uses, its specifications, and 
information on installation, safety, and system options.

Use the Getting Started manual to become familiar with the controls and indicators for your 
system and to learn about protocols, regions, panels, and the basic skills you need to operate 
the system. This manual also has an overview of the software.

Use the Operator’s Guide for the day-to-day running of your instrument. Go through the 
detailed step-by-step procedures of startup, quality control (QC), running samples, analyzing 
data, printing reports, reviewing QC data, and shutdown.

Use the Data Management manual for instructions on how to export, save, copy, move, 
archive, and delete files. It also has information about the types of files your system creates 
and uses, instructions for working with QC features, and instructions for setting up the report 
template that you need to create your patient reports.

Use the Special Procedures and Troubleshooting manual to clean, replace, or adjust a 
component of the instrument. The Troubleshooting tables and error messages appear at the 
back of the manual.

Use the Operating Summary as a quick reference for basic procedures.

Use the Master Index to easily locate a topic in any of your manuals.

Use the User's Comment Card in the Reference manual to give us your comments about the 
manual and ways to improve it.

ABOUT THIS MANUAL    
Your EPICS XL and XL-MCL Flow Cytometer Special Procedures and Troubleshooting 
manual describes how to clean, replace or adjust a component of the system. The 
Troubleshooting tables appear at the back of the manual.

This information is organized as follows:

 s Chapter 1, Cleaning Procedures
Provides procedures for cleaning parts of the system.

 s Chapter 2, Replace/Adjust Procedures
Provides procedures for replacing or adjusting parts.

 s Chapter 3, Troubleshooting
Describes how to troubleshoot the system with the error messages that appear on the screen.

 s Appendices
The appendices provide reference material on the following topics:
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INTRODUCTION
CONVENTIONS
 r Bar-Code Options
QC Maintenance Screen

 s Index
Use the Index to easily locate specific information in this manual.

CONVENTIONS
This manual uses the following conventions:

Throughout this manual your EPICS XL or XL-MCL flow cytometer is referred to as the 
system.

Italics indicate screen messages.

Bold indicates a menu item.

Courier font indicates text you have to type using the keyboard.

ë indicates a key (such as Û).

ë+ë indicates that the two keys listed (such as Þ+Ê) are linked for a specific function 
and must be pressed in this sequence:

1. Press down on the first key listed and while continuing to press it, press down on the 
second key listed.

2. Release both keys at the same time.

ë ë indicates to press and release the first key listed then press and release the next key 
listed. For example,  Y Û.

  File tt Save Select the Save item on the File menu.

 [OKAY] Use the mouse to click on the screen button labeled [OKAY].

É through Ô Special function keys.

ICONS

Press and release the left mouse 
button.

Operational check.

Turn on the system at the 
computer.

Turn off the system at the 
computer.

Open the Power Supply door. Power Supply.

Call your Coulter 

Representative.
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1
1CLEANING PROCEDURES

1.1 WHAT THIS CHAPTER EXPLAINS
This chapter explains how to clean the:

 r Air filters (weekly) after the shutdown procedure

 r Sheath fluid container (monthly) and cleaning agent container (every 60 days)

 r VACuum TRAP (VAC TRAP) on the Power Supply (as needed).

For daily cleaning procedures, see the Shutdown chapter in the Operator's Guide.

1.2 CLEANING THE AIR FILTERS

The instrument has five air filters. They 
are located on the:

 r Cytometer Back Panel

 r Power Supply, Inside Front Door

 r Power Supply, Back Panel

7027015C

7027016C
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CLEANING PROCEDURES
CLEANING THE AIR FILTERS
Prepare to Clean the Air Filters

1.   

Turn off the system at the computer.

2. Pull off each filter cover. Even 
though the covers look like they are 
screwed in, they are not.

The filter covers are made of flexible 
plastic; they snap out when you pull 
them. Grab a segment of the grille 
between your thumb and index 
finger and then pull.

3. Pinch and pull out each filter. 
Handle them gently to avoid 
damaging them.

7027020C

7027024C
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CLEANING PROCEDURES
CLEANING THE AIR FILTERS 1
Rinse and Return the Air Filters

1. Rinse each filter in water b, and 
then wring it out c.

2. Set each filter aside and let it dry 
out for about 30 minutes. Use paper 
towels to check that each filter is 
completely dry.

3. Return each filter to its holder; 
replace any torn ones.

4. Put each filter cover back on.

21

7027029C

7027025C

7027027C
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CLEANING PROCEDURES
IDLE MODE
1.3 IDLE MODE

5.   

Turn on the system at the computer.

6. Record that the air filters were 
cleaned on the QC Maintenance 
screen. See Appendix B for 
instructions.

7.
Do you want to use the 

instrument?

Yes No

Do the startup procedure 
in the Operator’s Guide.

You are 
done.

To clean or fill the reagent containers 
you need to put the Cytometer in the 
Idle mode.

To put the Cytometer in the Idle mode, 
press the RUN button.

You cannot open the reagent drawer 
unless the Cytometer is in the Idle mode; 
that is, when:

 r A level sense indicator is glowing 
(not flashing) red, or

 r The indicator in the Cytometer 
RUN button is flashing green.

The reagent drawer sits in a self-locking 
track. Pull open the drawer until it stops.

7027031C
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CLEANING PROCEDURES
REMOVING THE REAGENT CONTAINERS 1
1.4 REMOVING THE REAGENT CONTAINERS
Remove and clean the sheath fluid container once a month.

Remove and clean the cleaning agent container every 60 days.

Clean the reagent containers when the instrument indicates that the sheath fluid or cleaning 
agent is low, before you refill them.

If you replace a reagent container, clean it before using it.

To remove either reagent container:

1.

2. Remove the Cytometer center front 
panel.

3. Pull open the reagent drawer.

Is the instrument in the Idle 
mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds for 
the Cytometer to 
depressurize.

TM
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CLEANING PROCEDURES
REMOVING THE REAGENT CONTAINERS
4. Disconnect the tubing on the top of 
the container by pushing in on the 
metal clips on the connectors.

5. Pull open the reagent drawer all the 
way so you can disconnect the 
sensor at the back of the drawer by 
sliding its sleeve out. 

The sensor for the sheath container 
(shown here) is on the right; for the 
cleaning agent container, on the left.

6. Remove the container from the 
drawer, unscrew the cap and empty 
the container as completely as 
possible (sheath container is 
shown).

7. Clean up any spills or debris in the 
drawer.

7027095C

7027093C

7027096C
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CLEANING PROCEDURES
CLEANING THE SHEATH CONTAINER 1
1.5 CLEANING THE SHEATH CONTAINER

IMPORTANT  Misleading results could occur if you contaminate the sheath fluid container. Be careful not to 
contaminate the sheath fluid container. Do not let your fingers, paper towels, or other objects touch the 
inside of the container or the inside of its cap.

Remove and clean the sheath fluid 
container once a month.

Follow the steps in Heading 1.4, 
Removing the Reagent Containers, and 
then:

1. Fill the sheath container with 100 
to 200 mL of fresh IsoFlow™ 
sheath fluid. (Do not use any other 
type of sheath fluid.)

2. Screw the cap back on and then 
swirl the sheath fluid in the 
container, rinsing all surfaces.

7027100C

7027101C
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CLEANING PROCEDURES
CLEANING THE SHEATH CONTAINER
3. Empty the container as completely 
as possible.

4. Replace the sheath container as 
instructed in Heading 1.7, 
Replacing the Reagent Containers.

5. Record that the sheath fluid 
container was cleaned on the QC 
Maintenance screen. See Appendix 
B for instructions.

7027110C
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CLEANING PROCEDURES
CLEANING THE CLEANING AGENT CONTAINER 1
1.6 CLEANING THE CLEANING AGENT CONTAINER

Remove and clean the cleaning agent 
container every 60 days.

Follow the steps in Heading, 1.4, 
Removing The Reagent Containers, and 
then:

1. Fill the cleaning agent container 
with 50 to 100 mL of fresh IsoFlow 
sheath fluid. (Do not use any other 
type of sheath fluid.)

2. Screw the cap back on and then 
swirl the sheath fluid in the 
container, rinsing all surfaces.

3. Empty the container as completely 
as possible.

7027111C

7027112C

7027113C
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CLEANING PROCEDURES
CLEANING THE CLEANING AGENT CONTAINER
4. Fill the container with 50 to 100 mL 
of fresh COULTER CLENZ® 
cleaning agent. (Do not use any 
other type of cleaning agent.)

5. Screw the cap back on and then 
swirl the cleaning agent in the 
container, rinsing all surfaces.

6. Empty the container as completely 
as possible.

7. Replace the cleaning agent 
container as instructed in Heading 
1.7, Replacing Reagent Containers.

7027114C

7027112C

7027113C
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CLEANING PROCEDURES
REPLACING THE REAGENT CONTAINERS 1
1.7 REPLACING THE REAGENT CONTAINERS

8. Record that the cleaning agent 
container was cleaned on the QC 
Maintenance screen. See Appendix B 
for instructions.

1. Put the container back in the 
drawer. Check that the connector at 
the back of the container goes 
through the hole in the back of the 
drawer, and then reconnect the 
sensor (sheath sensor is shown). 

2. Slide the drawer back in part way; 
keep the neck of the container out.

3. Reconnect the tubing assembly by 
pushing down on the tubing inserts 
so that the tubing snaps into the 
connector.

4. Fill the reagent containers as 
instructed in Heading 2.2, 
Replacing Reagents.

5. Reposition the center front panel. 
See Heading 1.4, Removing the 
Reagent Containers, step 2.

7027103C

TM

7027115C

7027102C
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CLEANING PROCEDURES
CLEANING THE VACUUM TRAP
1.8 CLEANING THE VACUUM TRAP

Prepare to Clean VAC TRAP

Clean the vacuum trap as needed.

Check for fluid in the VACuum TRAP 
(VAC TRAP) on the front of the Power 
Supply as part of your daily startup 
procedure.

If the VAC TRAP is more than 
one-quarter full of fluid, empty and rinse 
it with tap water.

See Heading 1.3, Idle Mode, before 
cleaning the VAC TRAP.

WATER 
TRAP

VAC 
TRAP

VAC 
FILTER

SYS 
VAC

SYS 
PRESS

30 
PSI

PRESS
ADJ

SYSTEM POPWER

MCL POPWER

AIR 
FILTER

1.

2. Put about 1 mL of cleaning agent or 
sheath fluid in a test tube. Put the 
tube on the sample stage.

Is the instrument in the Idle mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds for 
the Cytometer to 
depressurize.

7296002A

B

A
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CLEANING PROCEDURES
CLEANING THE VACUUM TRAP 1
3.   

4. Turn off the system at the back of 
the Power Supply.

5.

O
N

O
F

F

SYSTEM
ON / OFFWASTE

LEVEL / PRESS

SYSTEM
POWER

LASER
POWER

PRESSURE

VACUUM

WASTE

WASTE
VENT

7027021C
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CLEANING PROCEDURES
CLEANING THE VACUUM TRAP
Find and Pull Out VAC TRAP

1. The VAC TRAP is the trap on the 
left. Lift the VAC TRAP assembly 
out of its bracket so that you can 
grasp the top of the assembly.

2. While using one hand to hold the 
top of the TRAP assembly, use the 
other hand to unscrew the VAC 
TRAP. Then, empty the VAC TRAP 
according to your local 
environmental regulations and your 
laboratory's procedures.

7027065C

WARNING  To prevent injury, avoid skin contact with the VAC TRAP and its associated tubing. The VAC 
TRAP and its associated tubing might contain residual biological material and must be handled with 
care. Clean up spills immediately. Dispose of the contents of the VAC TRAP in accordance with your 
local  environmental regulations and acceptable laboratory procedures.

7027068C
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CLEANING PROCEDURES
CLEANING THE VACUUM TRAP 1
Rinse and Return VAC TRAP to its Bracket

1. Rinse the VAC TRAP with water, 
and then shake out the excess 
water.

2. Insert the white center post, pointed 
end up, into the VAC TRAP 
assembly.

If the white center post in the VAC 
TRAP assembly is stuck in the up 
position, pull it down.

7027067C
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CLEANING PROCEDURES
CLEANING THE VACUUM TRAP
3. Carefully align the threads on the 
VAC TRAP jar with the threads on 
the VAC TRAP assembly and screw 
the VAC TRAP back into place.

4. Return the VAC TRAP assembly to 
its bracket.

5. Wipe up any spills.

7027066C

7027069C

AIR 
FILTER

SYS 
VAC

MCL P

7027070C
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CLEANING PROCEDURES
CLEANING THE VACUUM TRAP 1
6. Turn on the system at the Power 
Supply.

7.   

8. Check that no error messages are 
displayed. If there are, see Heading 
3.3, Error Messages.

9. Record that the vacuum trap was 
cleaned on the QC Maintenance 
screen. See Appendix B for 
instructions.

10.

O
N

O
F

F

SYSTEM
ON / OFFWASTE

LEVEL / PRESS

SYSTEM
POWER

LASER
POWER

PRESSURE

VACUUM

WASTE

WASTE
VENT

7027028C

Do you want to use the instrument?

Yes No

Do the startup 
procedure in 
the Operator’s 
Guide.
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CLEANING PROCEDURES
CLEANING THE SAMPLING SYSTEM
1.9 CLEANING THE SAMPLING SYSTEM

When to Clean the Sampling System
Routine daily cleaning helps to minimize instrument downtime.

 r Follow both Manual and Auto mode procedures for the XL-MCL flow cytometer.

 r For the XL flow cytometer, follow only the Manual mode procedures.

The two levels of cleaning for the system are:

 r Routine cleaning followed by sample head cleaning.

 r Vacuum line cleaning.

1. Perform the routine and sample head cleaning procedures:

 r When you change laboratory application procedures, especially if you are using vital 
fluorescent stains. If vital stains such as propidium iodide, ethidium bromide, 
acridine orange, thiazole orange, Coriphosphine-O, Fura 3, or fluorescein diacetate, 
are used, perform these cleaning procedures immediately after using the dyes.

 r Immediately prior to running any immunophenotyping application if vital stains are 
being used on the same instrument.

 r When you observe a significant increase in debris or background counts.

 r Before you perform the vacuum line cleaning procedure.

 r Before you perform the shutdown procedure.

2. Perform the vacuum line cleaning procedure:

 r When you change laboratory application procedures, especially if you are using vital 
fluorescent stains. If vital stains such as propidium iodide, ethidium bromide, 
acridine orange, thiazole orange, Coriphosphine-O, Fura 3, or fluorescein diacetate, 
are used, perform these cleaning procedures immediately after using the dyes.

 r Every 8 hours of continuous operation.

 r Before shutdown.

Routine Cleaning Procedure

WARNING  The cleaning solution is hazardous and can cause personal injury or damage clothing. Beckman 
Coulter urges its customers to comply with all national health and safety standards such as the use of 
barrier protection. This may include, but it is not limited to, protective eyewear, gloves, and suitable 
laboratory attire when operating or maintaining this or any other automated laboratory analyzer.

IMPORTANT  A cleaning solution that is not fresh can leave residual stain in the system and misleading 
results could occur when you change laboratory applications. Be sure to prepare a fresh cleaning solution 
before performing the cleaning procedure and use it within the same day.
PN 4237296CA1-18



CLEANING PROCEDURES
CLEANING THE SAMPLING SYSTEM 1
Manual Mode Procedure (XL and XL-MCL Flow Cytometers)

1. Prepare a cleaning solution of 1 part 
high-quality, fragrance-free bleach 
(5% solution of sodium 
hypochlorite - available chlorine) 
and 9 parts distilled water or 
IsoFlow sheath fluid.

Put 2 mL of the bleach solution in a 
test tube.

2. At the Cytometer:

Application tt Acquisition.

Panel.

Cleaning Panel.

[Okay].

3. Check that the Cytometer
status message reads Insert
Sample Tube.

If it does not, call your Coulter 
Representative.

4. Put the test tube containing the 
2 mL of bleach solution on the 
sample stage.

The sample stage rises and the 
bleach solution is aspirated.

9 

1 

7297136B

7418006A

7021009A

11

2
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CLEANING PROCEDURES
CLEANING THE SAMPLING SYSTEM
When the sample stage lowers, 
remove the tube.

5. Run three tubes of distilled water or 
IsoFlow sheath fluid.

6. Record that the routine cleaning 
was done on the QC Maintenance 
screen. See Appendix B for 
instructions.

7021203A

About 2 mL of distilled water
or sheath fluid in each

7296004B
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CLEANING PROCEDURES
CLEANING THE SAMPLING SYSTEM 1
Auto Mode Procedure (XL-MCL Flow Cytometer Only)

1. Put a test tube containing 2 mL of 
freshly prepared bleach solution in 
carousel position 1.

Then put three freshly prepared 
tubes, each containing about 2 mL 
of distilled water or IsoFlow sheath 
fluid, in positions 2, 3, and 4 of the 
carousel.

Do not reuse the tubes from the 
manual mode procedure.

Ensure that the cleaning panel is 
still selected. If not, select it.

2. Put the carousel in the MCL sample 
loader and close the carousel door. 
Press the AUTO button or click Run 
on the Workstation screen.

Press Y when the system asks Are 
you starting a new carousel?

Press N when the system asks Do 
you want to enter specimen ID?

3. When the MCL sample loader is 
done, remove the carousel.

4. Record that the routine cleaning 
was done on the QC Maintenance 
screen. See Appendix B for 
instructions.

1
 

2 3 4

 

7297137B

7418006A

7021068A
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CLEANING PROCEDURES
CLEANING THE SAMPLING SYSTEM
Testing for Residual Stain
If you use vital stains such as propidium iodide, ethidium bromide, acridine orange, thiazole 
orange, Coriphosphine-O, Fura 3, or fluorescein diacetate, you may want to test for residual 
stain after performing the routine cleaning procedure and before proceeding to your next 
application.

To test for residual stain, run unstained Immuno-Trol™ cells or CYTO-TROL™ control cells 
for your application to ensure that the autofluorescent population is where you normally 
expect it. If it is not, repeat the routine cleaning procedure.

Sample Head and Probe Cleaning Procedure

Manual Mode Procedure (XL and XL-MCL Flow Cytometers)

1. Prepare a cleaning solution of 1 part of 
high-quality, fragrance-free bleach (5% 
solution of sodium hypochlorite - 
available chlorine) and 9 parts of 
distilled water or IsoFlow sheath fluid.

While wearing latex gloves, apply the 
10% bleach solution to a gauze pad.

2. Carefully push the moistened gauze pad 
up against the inside of the manual 
sample head and scrub away any debris 
inside and around the sample probe.

Continue scrubbing the sample head 
and probe by pushing the head up and 
down 10 times during a 60-second 
period. Replace gauze as needed.

3. Rinse the sample head and probe with 
gauze moistened with water.

4. Perform the Vacuum Line Cleaning 
procedure.

9 

1 

7297136B

7418001A
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Auto Mode Procedure (XL-MCL Flow Cytometer Only)

1. Prepare a cleaning solution of 1 part 
of high-quality, fragrance-free 
bleach (5% solution of sodium 
hypochlorite - available chlorine) 
and 9 parts of distilled water or 
IsoFlow sheath fluid.

While wearing latex gloves, apply 
the 10% bleach solution to a gauze 
pad.

2. Open the MCL lid and remove the 
carousel if installed.

Carefully push the moistened gauze 
pad up against the inside of the 
MCL sample head and scrub away 
any debris inside and around the 
sample probe.

Continue scrubbing the sample 
head and probe by pushing the head 
up and down 10 times during a 
60-second period. Replace gauze as 
needed.

3. Rinse the MCL sample head and 
probe with gauze moistened with 
water.

4. Perform the Vacuum Line Cleaning 
procedure.

9 

1 

7297136B

7418002A
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Vacuum Line Cleaning Procedure

Auto Mode Procedure (XL-MCL Flow Cytometer Only)

1. Fill two cleaning adaptors with 5 
mL of distilled water.

2. Put one adaptor in position 1 of a 
carousel. Put the second adaptor in 
position 2. Orient the reservoirs 
toward the center of the carousel.

3. Put the carousel into the MCL and 
close the carousel door.

Check that the system is in the Idle 
mode with the RUN light flashing 
green. If not, press the RUN button 
to put the system into the Idle mode

Press the AUTO and CLEANSE 
buttons at the same time.

7021271B

7296005A

Adaptor with
distilled water
in position 1.

Adaptor with
distilled water
in position 2.

7418005A
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Manual Mode Procedure (XL and XL-MCL Flow Cytometers)

4. When Press Run to Initialize appears 
on the status line, remove the 
carousel.

5. Record that the vacuum line 
cleaning and cleanse cycle were 
done on the QC Maintenance 
screen. See Appendix B for 
instructions.

1. If the system is in the Run mode 
(the RUN button is glowing green), 
press the RUN button to take the 
system out of the Run mode. The 
RUN light blinks when the unit is 
not in the Run mode.

2. Fill a cleaning adaptor reservoir 
with 5 mL of distilled water.

3. Install the adaptor just as a sample 
tube is installed on the sample 
stage. 

Wait for the water to be aspirated 
before proceeding to step 4.4.

7021271B

7021270B
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CLEANING THE SAMPLING SYSTEM
4. Remove the adaptor and press the 
CLEANSE button.

When the cleanse cycle ends, the 
CLEANSE button indicator turns 
off and the RUN button indicator 
flashes. The Cytometer status 
message reads Press Run to Initialize.

5. Record that the vacuum line 
cleaning and cleanse cycle were 
done on the QC Maintenance 
screen. See Appendix B for 
instructions.

7021-056
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2REPLACE/ADJUST PROCEDURES

2.1 WHAT THIS CHAPTER EXPLAINS
This chapter has these replacement and adjustment procedures:

 r Filling the sheath container

 r Venting air bubbles

 r Filling the cleaning agent container

 r Emptying the waste container•Replacing the sheath filter

 r Replacing the sample head

 r Adjusting the system pressure

 r Positioning the neutral density filter.

2.2 REPLACING REAGENTS

About the Reagent Containers

The Cytometer has a reagent drawer that 
has containers for sheath fluid and 
cleaning agent.

The sheath container has a working 
capacity of about 2 L. A bottle of IsoFlow 
sheath fluid holds 1.8 L.

The cleaning agent container has a 
working capacity of about 500 mL, the 
amount in a small bottle of COULTER 
CLENZ cleaning agent.

For best use of reagents, refill the reagent 
containers only when the instrument 
indicates that they are low.

When you fill an empty reagent container, you need about 2.8 L of sheath fluid and 1 L of 
cleaning agent. The amount of reagent beyond the working capacity is for pressurization 
and level sensing.

If you replace a reagent container, clean it before you fill it (see Chapter 1, Cleaning 
Procedures). Record that the reagent containers were cleaned on the QC Maintenance 
screen. See Appendix B for instructions.

TM
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FILLING THE SHEATH CONTAINER
2.3 FILLING THE SHEATH CONTAINER

1.

2. Pull open the reagent drawer.

3. Unscrew the cap on the sheath 
container (A). To avoid 
contaminating the sheath fluid, lay 
the cap upside down on the 
container (B).

Is the instrument in the Idle mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds 
for the Cytometer to 
depressurize.

TM

IMPORTANT  Misleading results could occur if you contaminate the sheath fluid. Be careful not to 
contaminate the sheath fluid. Do not let your fingers, paper towels, or other objects touch the inside of 
the container or the inside of its cap.

1

2

TM

7027033C
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REPLACE/ADJUST PROCEDURES
FILLING THE SHEATH CONTAINER 2
4. Carefully pour fluid into the 
container, filling it just to the 
bottom of its neck.

5. Carefully wipe up any spills.

6. Screw the cap back on.

CAUTION  To prevent damage to the instrument, do not overfill the sheath container. Avoid spills. Do not 
tilt the container or remove it from the drawer to fill it.

TM

7027035C

IMPORTANT  Misleading results could occur if you analyze samples without the cap on the sheath 
container. Be sure to put the cap back on the sheath container after you fill it.

TM

7027036C
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FILLING THE SHEATH CONTAINER
7.
Are bubbles in the vent tubing?

Yes No

Go to 
Heading 2.4, 
Venting Air 
Bubbles

Close the reagent 
drawer, and press 
the RUN button. 
The indicator in the 
button glows (not 
glashes) green.

Do the quality 
control procedure in 
the Startup chapter 
of the Operator’s 
Guide.
PN 4237296CA2-4
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VENTING AIR BUBBLES 2
2.4 VENTING AIR BUBBLES

The vent button lets you release bubbles 
that are in the sheath filter and in the 
tubing for the sheath fluid.

While the reagent drawer is open, the 
vent button in the drawer is deactivated. 
This means that you cannot use the vent 
button unless the drawer is closed and 
the Cytometer is in the Run or Prime 
mode.

Remove the Cytometer center front 
panel so you can reach the vent button 
when the reagent drawer is closed.

1. Check that:

 r The vent port is above the 
connector and pointing toward 
you.

 r The tubing is not kinked or 
twisted.

2. Close the reagent drawer.

TM

VENT
PORT

CONNECTOR

7027109C
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REPLACE/ADJUST PROCEDURES
VENTING AIR BUBBLES
3. Remove the Cytometer center front 
panel.

4. Put the system in the Run or Prime 
mode.

5. Press and hold the vent button until 
the bubbles in the vent tubing are 
gone.‘

6. Reposition the center front panel. It 
snaps into place.

7. Do the quality control procedure in 
the Startup chapter of the 
Operator's Guide.

7027031C

O.K.

7027040C
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2.5 FILLING THE CLEANING AGENT CONTAINER

1.

2. Pull open the reagent drawer.

3. Unscrew the caps on the cleaning 
agent container and the cleaning 
agent bottle.

Is the instrument in the Idle mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds 
for the Cytometer to 
depressurize.

TM

IMPORTANT  Misleading results could occur if you contaminate the cleaning agent. Be careful not to 
contaminate the cleaning agent. Do not let your fingers, paper towels, or other objects touch the inside of 
the container or the inside of its cap.

7027044C
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REPLACE/ADJUST PROCEDURES
FILLING THE CLEANING AGENT CONTAINER
4. Carefully pour cleaning agent into 
the container, filling it just to the 
bottom of its neck.

5. Carefully wipe up any spills.

6. Screw the cap back on.

CAUTION  To prevent damage to the instrument do not overfill the cleaning agent container. Avoid spills. 
Do not tilt the container or remove it from the drawer to fill it.

� � � �

7027046C

7027047C
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REPLACE/ADJUST PROCEDURES
FILLING THE CLEANING AGENT CONTAINER 2
7. Check that:

 r The vent port is above the 
connector and pointing toward 
you.

 r The tubing is not kinked or 
twisted.

8. Close the reagent drawer.

9.

VENT
PORT

CONNECTOR

7027109C

Do you want to analyze samples?

Yes No

Press the RUN 
button. The 
indicator in the 
button glows (not 
flashes) green.

You are done.
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EMPTYING THE WASTE CONTAINER
2.6 EMPTYING THE WASTE CONTAINER

Your  instrument has a 4-L waste 
container that sits in a bracket on the 
right side of the Power Supply. Empty it 
and follow these steps to  put chlorine 
bleach in it.

1.

2. Lift the waste container out of its 
bracket and swirl it before removing 
the cap.

®

Is the instrument in the Idle mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds 
for the Cytometer to 
depressurize.

7027050C
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REPLACE/ADJUST PROCEDURES
EMPTYING THE WASTE CONTAINER 2
3. Unscrew the cap and lay it on a 
leakproof disposable container, 
such as a glove or beaker. 

4. Empty the waste container according 
to your laboratory's procedures.

5. Put about 400 mL of high-quality, 
fragrance-free bleach (5% sodium 
hypochlorite -available chlorine) in 
the waste container to cover the 
bottom of the container.

WARNING  To prevent injury, avoid skin contact with the waste container and its associated tubing. The 
waste container and its associated tubing might contain residual biological material and must be handled 
with care. Clean up spills immediately. Dispose of the contents of the waste container in accordance with 
your local regulations and acceptable laboratory procedures

7027049C

7027051C
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REPLACE/ADJUST PROCEDURES
EMPTYING THE WASTE CONTAINER
6. Screw the cap back on.

7. Wipe the bracket with a paper towel 
moistened with a 10% bleach 
solution, and then return the 
container to the bracket.

8.

7027053C

Do you want to analyze samples?

Yes No

Press the RUN 
button. The 
indicator in the 
button glows (not 
flashes) green.

You are done.

7027052C
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2.7 REPLACING THE SHEATH FILTER

The 0.2-µm sheath filter is in the 
Cytometer reagent drawer. 

Replace the sheath filter,

 r Every 6 months.

or

 r Whenever the sample flow rate is too 
high (repeated data rate warnings or 
system pressure warnings).

1.

2. Open the reagent drawer.

TM

Is the instrument in the Idle mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds 
for the Cytometer to 
depressurize.

TM
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REPLACE/ADJUST PROCEDURES
REPLACING THE SHEATH FILTER
3. Pick up the old sheath filter, and 
notice how the three tubes are 
connected. Turn the filter and notice 
the direction of the arrow on it.

4. Get the new filter and hold it with 
the arrow going in the same 
direction as the arrow on the old 
filter. In the next step, immediately 
install the new filter to avoid spills.

5. Disconnect and reconnect each tube 
to the new filter, one at a time, 
beginning with B. The tubes are 
disconnected by pushing in on the 
metal clips on the connectors. 
When reconnected, the connectors 
snap into place.

6. Wipe up any spills, and then put the 
filter in the drawer. 

Check that:

 r The vent port is above the 
connector and pointing toward 
you.

 r The tubing is not kinked or 
twisted.

7. Record that the sheath fluid filter 
was replaced on the QC 
Mainenance screen. See Appendix B 
for instructions.

CAUTION  Damage to the instrument can occur if you do not install the sheath filter correctly. It allows 
fluid to flow in one direction only. Make sure you install the new sheath filter correctly.

OLD
SHEATH
FILTER

NEW
SHEATH 

FILTER

2

3

PUSH
HERE 1

2

3

1

7027055C

VENT
PORT

CONNECTOR

7027107C
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REPLACE/ADJUST PROCEDURES
REPLACING THE MANUAL SAMPLE HEAD 2
2.8 REPLACING THE MANUAL SAMPLE HEAD

8.
Are bubbles in the vent tubing?

Yes No

Go to 
Heading 2.4, 
Venting Air 
Bubbles

Close the reagent 
drawer, and press 
the RUN button. 
The indicator in the 
button glows (not 
glashes) green.

Do the quality 
control procedure in 
the Startup chapter 
of the Operator’s 
Guide.

Replace the sample head whenever,

 r Sample stage does not go up after a 
sample tube is inserted and Insert 
Sample Tube is displayed in red on 
the monitor.

 r Sample head silicone seal is cut or 
nicked.

 r Monitor displays Sample Pressure 
Error and system pressure is 
between 28 and 32 psi.

 r You always have to use the PRIME 
button to start data acquisition.

1.
Is the instrument in the Idle mode?

Yes No

Go to 
step 2.

Press the RUN button. 
The indicator in the 
button flashes green.

Wait about 10 seconds 
for the Cytometer to 
depressurize.
PN 4237296CA 2-15
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REPLACING THE MANUAL SAMPLE HEAD
2. At the sample stage, remove the two 
Allen screws securing the test tube 
guide around the sample head.

3. Remove the test tube guide and set 
it aside.

4. Pull down on the sample head while 
turning it to the left and slide it off 
the sample probe.

5. Transfer the tubing from the old 
head to the new head one at a time.

7027118C
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REPLACE/ADJUST PROCEDURES
REPLACING THE MANUAL SAMPLE HEAD 2
6. Slide the new sample head onto the 
sample probe and up into the head 
seat with the tubing facing the back.

7. Install the test tube guide using the 
two Allen screws from step 2.

8. Record that the manual sample head 
was replaced on the QC 
Mainenance screen. See Appendix B 
for instructions.

SAMPLE
HEAD

SAMPLE
PROBE

7027120C

7027122C
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2.9 ADJUSTING THE SYSTEM PRESSURE

The startup procedure in the Operator's 
Guide tells you to check the System 
PRESSure gauge reading on the Power 
Supply daily. If the reading is not 
30 ±2 psi, follow these steps to adjust it.

1.

2. Pull the collar around the PRESSure 
ADJuster out toward you.

3. Adjust the pressure to 30 ±2 psi. 
Turn to the left to decrease; to the 
right to increase.

WATER 
TRAP

VAC 
TRAP

AIR 
FILTER

VAC 
FILTER

SYS 
VAC

SYS 
PRESS

30 
PSI

PRESS
ADJ

SYSTEM POPWER

MCL POPWER

7297133A

7027061C

(-)

(+)
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REPLACE/ADJUST PROCEDURES
ADJUSTING THE SYSTEM PRESSURE 2
4. Push in on the collar to lock it into 
place.

5. Record that the system pressure was 
adjusted on the QC Mainenance 
screen. See Appendix B for 
instructions.

7297134A
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2.10 POSITIONING THE NEUTRAL DENSITY FILTER

If your laboratory primarily analyzes 
large particles (for example, plant cells), 
use the neutral density (ND1) filter. You 
do not need to install it. The filter is 
already in the Cytometer.

You position the ND1 filter by sliding a 
spring-loaded knob along a track. When 
the knob is at the right end of its track, 
the filter is not used. Follow these steps 
to position the ND1 filter.

1. Remove the Cytometer center front 
panel.

2. Slide the knob all the way to the left 
end of its track, and then push it in 
to lock it into position. Do not try 
to screw the knob in; doing so has 
no effect.

1 2 3

4 5 6 7 8

9

TM

Filter in use.

7027071C
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POSITIONING THE NEUTRAL DENSITY FILTER 2
3. Reposition the Cytometer center 
front panel. It snaps into place.

4. If you decide to stop using the ND1 
filter, pull out on the knob to 
unlock it, and then guide the knob 
to the right end of its track.
PN 4237296CA 2-21
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2.11 RESETTING THE CIRCUIT BREAKERS

  

Check the 
indicators on the 
front of the Power 
Supply. If any of 
them are off, follow 
these steps to reset 
the appropriate 
circuit breakers:

1. On the back of the Power Supply, 
find the circuit breaker that 
corresponds to the dark indicator on 
the front:

2. Put the circuit breaker in the 0 
position, and then return it to the 1 
position.

3.       

4. On the back of the Power Supply, 
turn off the system and then turn it 
back on to finish resetting the 
instrument.

System 
POWER 
Indicator

Circuit
Breaker

+5 V 5 VOLTS
+15 V 15 VOLTS
-15 V 15 VOLTS
+24 V 24 VOLTS

MCL POWER 
Indicator

Circuit
Breaker

+5 V MCL 5 VOLTS
+12 V MCL 5 VOLTS
-12 V MCL 5 VOLTS
+24 V MCL 24 VOLTS
PN 4237296CA2-22
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3TROUBLESHOOTING

3.1 LEVEL SENSE INDICATORS

Cleanse Low
When the cleanse low indicator is red, fill the cleanse container. You cannot start a cleanse 
cycle until this is done.

Sheath Low
During sample analysis, you have 5 minutes to finish analyzing the current sample after the 
indicator starts flashing red.

When the indicator glows red, you must fill the sheath fluid container (refer to Heading 2.2, 
Replacing Reagents) before you can analyze samples or use the instrument.

Waste Full
During sample analysis, you have 5 minutes to finish analyzing the current sample after the 
indicator starts flashing red.

When the indicator glows red, you must empty the waste container (refer to Heading 2.6, 
Emptying the Waste Container) before you can analyze samples or use the instrument.

To Print the Carousel Summary Report
If a full waste container is detected while the last sample in a carousel is being analyzed, the 
carousel summary report is not printed. To print the report:

Applications tt Acquisition.

[Alt Save].

[Print Carousel Report].
PN 4237296CA 3-1
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ERROR MESSAGE LOG
3.2 ERROR MESSAGE LOG
The last 200 error messages from the Cytometer/instrument are stored in the error message 
log. 

Press  Þ + z to access the error message log when you are in Acquisition or Listmode. 

Use the arrow keys, ä, å, â, and ã to move within the error message log 
and view the messages.

Searching the Error Message Log
To search for a specific word or phrase listed anywhere in the error message log:

1. Press Þ + z to access the error log.

2. Turn ê Off on the keyboard.

3. Press à.

4. In the prompt box, type in the number, word, or phrase to find and press Û.

5. The first page containing corresponding entries (highlighted in red) appears.

6. Press ß to display the next page with corresponding search entries.

7296010B
PN 4237296CA3-2
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3.3 ERROR MESSAGES
Error messages appear:

 r In the center of the Workstation screen, and

 r In the lower right corner of the Acquisition Run screen (instrument errors only).

 r In the error log, which appears after you press Þ + z. Refer to heading 3.2, Error 
Message Log, for details.

To acknowledge an error message that appears in the center of the screen:

 r Press and release either mouse button, OR,

 r Press Û.

To acknowledge an error message in the lower right corner of the Acquisition Run screen, put 
the cursor on the message and press a mouse button.

About the Error Messages Table
Table 1 lists the error messages in alphabetical order, with their cause and what to do about 
them.

Call your Coulter Representative if:

 r The recommended action does not solve the problem.

 r You need help.

Table 3.1  Error Messages

Message Cause Action

%Lymph + %Mono +%Gran + %Blast 
> 100.0

The sum of these cannot be >100. Correct the entries so that the sum is 
£100.

A
A region must first be selected You tried to do a region operation 

before selecting a region.
Select a region and then repeat the 
operation.

All other errors Errors detected. Call your Coulter Representative.

All regions are already assigned You tried to create more than 24 
regions.

Delete some existing regions and then 
create new ones.

Allowable levels: 8 to 65535 or 0 for 
AUTO

System cannot accept the value 
entered.

Enter values between the specified 
range, or 0 for auto scaling.  

Amorphous regions not allowed in 
prism equation

System cannot create a prism divider 
using an amorphous region.

Assign a nonamorphous region to the 
prism equation.

Analysis date earlier than DOB The analysis date is earlier than the 
date of birth.

Check the dates and correct as needed.

Analysis date-time earlier than 
Collection date-time

The analysis date and/or time is earlier 
than the collection date and /or time.

Check the dates and times and correct 
as needed.

An empty string is not a valid 
password

A password may not consist of an 
empty string.

Enter a password by typing a sequence 
of characters.
PN 4237296CA 3-3
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ERROR MESSAGES
An internal error has occurred Internal error occurred while 
initializing the Single or Dual Overlay 
screen.

1. Exit SYSTEM II Software.
2. Restart SYSTEM II Software.
3. From the Multigraph application, 

select the desired overlay screen.
4. If error persists, call your Coulter 

Representative.

Apparent File Load Error Error occurred when trying to load a 
Listmode file.  A possible corrupted or 
missing file exists in the directory.

Rebuild directory.

OR

Reselect file to load.

Autosetup Cycle Terminated The current Autosetup protocol was 
aborted.  Autosetup cannot be 
performed.

1. Prime the system.
2. Check the order of the test tubes. 
3. Check that cells appear in the 

Prime region of the histogram.
4. Do not pause for long periods of 

time while running Autosetup.

B
Bar Code Printer NOT present or 
wrong type

System cannot print bar code labels. 1. Ensure the printer is turned ON.
2. Ensure the printer is connected to 

the correct COM port.
3. Make sure your printer is allowed 

for use by SYSTEM II software.

C
Calibrator Region already exists System can assign only one CAL 

region per protocol.
Remove the existing Calibrator region 
and then you can assign a Calibrator to 
another region.

Cannot assign CALIBRATOR to a 
Quadstat

System cannot assign a CAL region to 
a Quadstat.

Reassign the CAL region to a region 
type other than Quadstat.

Cannot be started -- [name] Database cannot be started. Check name of server path.

Cannot convert [name] to a [name] An invalid value has been supplied to 
or retrieved from the database.

Change the value that is causing the 
problem.

OR

Restart the database.

Cannot find this region The region identified as the minimum 
event counter does not exist in the 
current protocol.

Change the minimum event counter to 
a region that exists in the current 
protocol.

OR

Create a region in the protocol for the 
minimum event counter.

Table 3.1  Error Messages (Continued)

Message Cause Action
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ERROR MESSAGES 3
Cannot get Cytometer ready Laser defective or not ignited.

No vacuum.

Incorrect pressure.

See Heading 2.11, Resetting the Circuit 
Breakers.

Cannot get sample information from 
MCL

Software error.

Bad bar-code label on carousel or 
sample tube.

Clean the carousel or use a new one.

OR

Check condition and placement of 
bar-code label on sample tube.

Cannot open log file [name] Database engine was not able to open 
the transaction log file.

Specify the correct device or directory 
using the DBLOG utility.

Cannot open protocol queue file File load error.

No file.

You specified the wrong path.

Specify the correct directories on the 
Utilities Configuration screen.

OR

From the File menu, select Rebuild.

Carousel completed ... cannot continue Current carousel is finished; no more 
tubes to run.

Restart the current carousel.

OR

Select a new carousel.

Carousel restart error The MCL failed to activate the carousel 
and go to the designated tube.

1. Restart the MCL.
2. If error persists, reset the 

Cytometer by powering down.

Caution: No histograms were noted Protocol is missing histograms. Create histograms.

Channel overflow condition exists At least one channel in the histogram 
has more than 65535 events.

None.

Counter not available You tried to specify more than 3 stop 
counts.

Delete an existing stop count and then 
create a new one.

Cleanse Level Error Low cleaning agent. Fill cleaning agent container.

Cleanse sensor failed. Call your Coulter Representative.

Cleanse Level Okay There is enough cleanse fluid to 
perform a cleanse cycle.

None. Informational only.

Cleanse Level Warning Low cleaning agent. Fill cleaning agent container.

Cleanse sensor failed. Call your Coulter Representative.

Client/server communications protocol 
mismatch

Client unable to start due to different 
versions.

Ensure the client and server software 
are the same version.

Collection date earlier than DOB You entered a sample collection date 
that was earlier than the date of birth.

Check the dates and correct as needed.

Com. Port unavailable COM port used to export files is not 
functional or is not present.

At the Utilities screen COM port setup, 
ensure the Workstation has correct 
COM port.

Comm. complete Export action was successful. No action. Informational only.

Table 3.1  Error Messages (Continued)

Message Cause Action
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Communication error Communication error between client 
and server.

1. Exit program.
2. Restart program.
3. Ensure server is running correctly.

Confirmation failed When changing a supervisor password 
in the Maintenance screen, the user 
must type in the new password twice. 
This message indicates that the two 
times the user typed in the new 
password, these did not match.

Make sure the new password is typed 
in the same way both times.

Connection not found Specified database was not found. Check environment for correct 
database name.

Connections to database have been 
disabled

Database server connections are 
disabled.

Enable connections at the server.

Counter not available The system was unable to enable the 
volume stop, since all counters are 
currently used.

Free up one of the Counters for use 
with volume.

Crit [DOS | FAT | Disk Directory | Files] 
err [Reading | Writing] [drive]: [error 
type]

An operating system critical error 
occurred during a disk access.

Call your Coulter Representative.

Crit Non Disk err: [error type] An operating system critical error 
occurred, but not during a disk access.

Check that the removable disk is in 
place.

If error occurs again, call your Coulter 
Representative.

Current Worklist may NOT be selected User tried to select and load a panel 
named ‘Current Worklist’.

SYSTEM II Software does not permit 
loading of this panel. It is created when 
the user selects a Worklist to run.

Select another panel.

Cyto_change_error An error occurred while trying to 
adjust the cytometer voltage, 
compensation, or discriminator.

1. Repeat operation.
2. If error persists, reset the 

Cytometer by powering down.

Cytometer communications failure 
during file load

System unable to send the Cytometer 
program file to the Cytometer.

1. Restart system software.
2. If error persists, reset the 

computer then restart the software.

Cytometer error The Cytometer did not respond. A 
timeout error occurred.

1. Repeat operation.
2. If error persists, reset the SYSTEM 

II Software.
3. If error still persists, reset the 

computer and restart the SYSTEM 
II Software.

Cytometer program file not found System unable to find the Cytometer 
program file.

Ensure the files (*.btl) are under the 
C:\XL directory or call your Coulter 
Representative.
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Cytometer read cyto state timeout Cytometer communication error. At the Workstation turn the system off, 
and then turn it back on.

D
Data Memory Problem Memory failure. Reset computer. If error persists, call 

your Coulter Representative.

Data rate error Data rate too high for Cytometer data 
handling.

Dilute sample or change discriminator 
setting. Check that the sheath tank cap 
is tightened.

Data Rate Warning The discriminated data rate exceeded 
6,000 cells per second.

Dilute sample or change the 
discriminator setting. Check that the 
sheath tank cap is tightened.

Data Stream Error Data acquisition hardware error Call your Coulter Representative. 

Data Stream Okay Communication between the data 
acquisition hardware and the 
Cytometer software has been 
established.

None. Informational only.

Data Stream Warning Data acquisition hardware error Call your Coulter Representative. 

Database engine not running Database engine or network requester 
has not been run.

Check environment and server.

Database engine not running in 
multi-user mode

The database was started for bulk load 
with the ‘-b’ runtime switch.

1. Stop the database by exiting 
SYSTEM II Software.

2. Restart SYSTEM II Software 
without the ‘-b’ switch.

Database name required to start 
engine

No database name was specified. Specify a database name through the 
environment.

Database was initialized with an older 
version of the software

Database is missing some system 
table definitions of the new version.

1. Unload the database.
2. Reload the database into a 

database initialized with newer 
WSQL.

Dblib/database engine version 
mismatch

Mismatch between database and 
engine.

Reload/reinstall correct version of the 
database.

DEFAULT is a reserved name DEFAULT is a reserved word within the 
SYSTEM II Software and cannot be 
used to save your configuration.

Use a different name than DEFAULT.

Disk full -- transaction rolled back Disk is out of free disk space. Remove or archive files which are not 
needed.

Do not have permission to [name] Specified user does not have 
permission to use this database.

Change the user ID or supply the 
correct level of permission.

Duplicate entry not possible The system can create only one report 
for the Acquisition run.  An Acquisition 
entry has been detected in the 
database.

Generate a Listmode patient report 
that allows multiple entries.
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E
Equation(s) exceed defined limitations Software failure. At the Workstation turn the system off, 

and then turn it back on.

ERROR: 2 parameter histograms not 
allowed

You selected a two-parameter 
histogram as control or test.

Select a one-parameter histogram.

Error accessing panel file System unable to add the selected 
panel to the Worklist.

1. Ensure the directory path is 
correct.

2. Rebuild the panel directory.
3. Repeat the operation.

Error accessing password The file containing the supervisor 
password in the Maintenance screen is 
either missing or damaged.

First time use of the Supervisor box in 
the Maintenance screen creates the 
password file.

Error allocating extended memory Software cannot allocate extended 
memory.

At the Workstation turn the system off, 
and then turn it back on.

Error building WorkList panel Program could not build Worklist. 1. Ensure all fields in the Worklist 
screen are correctly filled out.

2. Ensure all entries used have an 
assigned protocol.

ERROR: Channel resolution of 
histograms are different

You selected control and test 
histograms with different resolutions.

Select other control and/or test 
histograms.

Error creating WorkList LoadList Program could not create Worklist. 1. Ensure all fields in the Worklist 
screen are correctly filled out.

2. Ensure all entries used have an 
assigned protocol.

ERROR!  DEFAULT is a reserved name You entered “Default” as a name. Enter another name.

ERROR!  <your file name> does not 
exist in this directory!

Software cannot find the named file in 
the directory.

From File menu, select Rebuild.

Error forming queue System program error. Call your Coulter Representative.

ERROR: Histogram Log decades are 
different

You selected control and test 
histograms with different log types.

Select other control and/or test 
histograms.

Error in acquiring Cytometer could not acquire data. 1. Turn system off at Workstation.
2. Turn the system on again.

Error in entry System is unable to accept your input. Enter the correct value.

Error in equation System unable to compute the 
equation entered.

1. Verify the validity of the equation.
2. Check that the equation line labels 

are lower case letter combinations, 
such as: aa, ab, and so forth.

ERROR IN LOADING DATA System cannot find the Listmode file.  
Either it does not exist, it is corrupted, 
or does not have enough memory to 
load.

Rebuild the directory or select another 
file.
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Error in loading protocol Software cannot access protocol file. From File menu, select Rebuild.

Error in rename listmode file File write error.

Hard disk error

Select Alt Save and repeat save.

Error in sending all the compensation 
values of the signals

Workstation/Cytometer 
communication error

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending all the gain settings to 
Cytometer

Workstation/Cytometer 
communication error

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending all the pertinent time 
parameters to Cytometer

Workstation/Cytometer 
communication error

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending all the signals 
selected as parameters during 
acquisition

Workstation/Cytometer 
communication error.

1. See Heading 2.11, Resetting the 
Circuit Breakers.

2. At the Workstation, turn the 
system off.

3. Turn the system on again.

Error in sending compensation to 
Cytometer

Workstation/Cytometer 
communication error

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending discriminators to 
Cytometer

Workstation/Cytometer 
communication error.

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending ratio's numerator and 
denominator to Cytometer

Workstation/Cytometer 
communication error.

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending sample pressure Workstation/Cytometer 
communication error.

1. At the Workstation, turn the 
system off.

2. Turn the system on again.

Error in sending signal with the 
discriminator set

Workstation/Cytometer 
communication error.

1. At the Workstation, turn the 
system off.

2. Turn the system on again. At the 
Workstation turn the system off, 
and then turn it back on.

Error in sending signals to Cytometer Workstation/Cytometer 
communication error

1. See Heading 2.11, Resetting the 
Circuit Breakers.

2. At the Workstation, turn the 
system off.

3. Turn the system on again.

Error in setting Cytometer in the 
awaiting sample state

Workstation/Cytometer 
communication error.

At the Workstation turn the system off, 
and then turn it back on.
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Error in writing file You specified the wrong path.

Full disk.

Specify the correct directories on the 
Utilities Configuration screen.

OR

Use archive on the Utilities 
Configuration screen and free up disk 
space.

Error in writing file, Carousel aborted 
on tube # [tube number]

System cannot save file to the local 
path.  Possible full disk.

At the Utilities Configuration screen, 
specify the correct directories.

OR

Use Archive to free up disk space.

Error in writing file, Current operation 
aborted

System cannot save file to the local 
path.  Possible full disk.

At the Utilities Configuration screen, 
specify the correct directories.

OR

Use Archive to free up disk space.

Error initializing protocol An internal error initializing the 
memory for histograms was detected.

1. Exit the SYSTEM II Software.
2. Restart the software.
3. Enter the Multigraph application.
4. If the problem persists, call your 

Coulter Representative.

Error installing clock interrupt vector SYSTEM II Software cannot properly 
initialize itself.

1. Power off the Workstation.
2. Wait a few minutes, then turn the 

power on again to the Workstation.
3. If error persists, call your Coulter 

Representative.

Error installing Cytometer interrupt 
vector

Cytometer interrupt has not been 
installed correctly.

1. Restart the SYSTEM II Software.
2. If error persists, reset the 

computer then restart SYSTEM II 
Software program.

Error installing interrupt [hexadecimal 
number] handler

SYSTEM II Software cannot properly 
initialize itself.

1. Power off the Workstation.
2. Wait a few minutes, then turn the 

power on again to the Workstation.
3. If error persists, call your Coulter 

Representative.

Error: Invalid path selected You entered an invalid path. Enter another path.

Error loading cytometer program file Software unable to program the 
Cytometer.

At the Workstation turn the system off, 
and then turn it back on.

Error loading file System cannot load the selected file. 1. Repeat the operation.
2. If error persists, then the file is 

either missing or is damaged.

ERROR LOADING LISTMODE FILE Program cannot access Listmode file. From File menu, select Rebuild.

ERROR LOADING PROTOCOL Program cannot access protocol file. From File menu, select Rebuild.
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ERROR: Mouse Driver Not Present No mouse is detected. Tighten mouse connector.

At the Workstation turn the system off, 
and then turn it back on.

No mouse driver is installed. Call your Coulter Representative. 

ERROR! Name must not consist 
entirely of spaces

You entered a name consisting of all 
blank spaces.

Enter another name.

ERROR: No more entries may be 
selected

The maximum number of protocols in 
a panel is 32.

Delete some protocols and then add 
others.

ERROR: Not enough memory to 
calculate amorphous statistics

System needs more memory to 
calculate the statistics for an 
amorphous region.

At the Workstation turn the system off, 
and then turn it back on.

ERROR!  Possible full disk Software cannot write information to 
file.

Specify the correct directories on the 
Utilities Configuration screen.

OR

Use archive on the Utilities 
Configuration screen and free up disk 
space.

Error reading Carousel file The Panel Loadlist file could not be 
read.

1. Ensure that the panel loadlist file 
exists.

2. Run MCL again.

ERROR!  Requested file does not exist 
in this directory

Software cannot find the file in the 
directory.

From File menu, select Rebuild.

Error saving file The System detected an error during 
the file save operation.

Repeat the operation.

Error stop Cytometer Workstation/Cytometer 
communication error

At the Workstation turn the system off, 
and then turn it back on.

ERROR! Unable to access file Software cannot load the file. Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

ERROR! Unable to access file <your 
file name>

Software cannot load the named file, 
or the named file is invalid.

Specify the correct directories on 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

ERROR! Unable to get the available 
disk space for the specified drive 

Software cannot calculate the available 
disk space.

At the Workstation turn the system off, 
and then turn it back on.

ERROR: Unable to receive cytometer's 
program version

Instrument cannot receive Cytometer 
program’s version.

At the Workstation turn the system off, 
and then turn it back on.

ERROR! -- Unable to read non-XL 
protocols!

Instrument can use protocol files 
created using the XL or XL-MCL flow 
cytometer software only.

Use a valid protocol.
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Error validating your entry An internal error occurred when 
creating a minimum counter.

1. Exit SYSTEM II Software.
2. Call your Coulter Representative.

ERROR writing to file [file name]! 
Possible full disk

Software cannot save information to 
the named file.

Specify the correct directories on the 
Utilities Configuration screen and

use archive on the Utilities 
Configuration screen and free up disk 
space.

Error writing to log file The database engine receiving an I/O 
error writing the log file.

1. Ensure the disk is not full.
2. Ensure the log file name is valid.

F
‘Fm__system’ not allocated Internal error. 1. Exit SYSTEM II Software.

2. Call your Coulter Representative.

Fail to close Listmode file Hard disk error. Full disk. Use archive on the Utilities 
Configuration screen and free up disk 
space.

Fail to close Listmode file, Carousel 
aborted on tube #[tube number]

Hard disk error.  Full disk. Use archive on the Utilities 
Configuration screen and free up disk 
space.

Fail to close Listmode file, Current 
operation aborted

Hard disk error.  Full disk. Use archive on the Utilities 
Configuration screen and free up disk 
space.

Failed to read MCL state MCL status is unknown. 1. Repeat the operation.
2. If the error persists, power off the 

Cytometer and restart the SYSTEM 
II Software program.

Failed to update password When user attempted to change an old 
password in the Maintenance screen 
for a new one, the file could not be 
found or was damaged.

First time use of the Supervisor box in 
the Maintenance screen creates the 
password file. If this is not the case, 
restart the SYSTEM II Software. If 
problem persists, get out of the 
SYSTEM II program and reboot the 
computer.

Failure to resume panel: [panel name] MCL could not continue with the 
current panel.

1. Try to continue with MCL.
2. If the error persists, restart the 

SYSTEM II Software program.

Failure to resume Protocol: [protocol 
name]

MCL could not continue with the 
current protocol.  (The MCL was 
running a single protocol.)

1. Try to continue with MCL.
2. If the error persists, restart the 

SYSTEM II Software program.

[Filename] does NOT exist The selected file does not exist under 
the current directory path.

Ensure the directory path is correct.

Table 3.1  Error Messages (Continued)

Message Cause Action
PN 4237296CA3-12



TROUBLESHOOTING
ERROR MESSAGES 3
[Filename] does not exist in this 
directory!

Error opening the current panel file. 1. Exit SYSTEM II Software.
2. Restart the program.
3. If error persists, reboot the 

Workstation.

File name is <QC file name> The file being translated to a test file 
(used with a spreadsheet program) is 
not a QC file.

Check the file to be used as a source 
file for the translation and make sure it 
is a QC file (with QCS or QCC 
extension).

FILE [filename] REMOVED QC file has been removed. Rerun panel to re-create the QC file.

File larger than 32768 bytes File could not be exported or sent 
through COM port since it exceeded 
the maximum allowable size.

No action.

File problem Damaged QC file. 1. Delete the QC file.
2. Rerun the panel to re-create the QC 

file.

File Write Error [file name] Damaged QC file. 1. Delete the QC file.
2. Rerun the panel to re-create the QC 

file.

File Write Error - <QC file name> The QC file currently being updated 
had a write error.

Run the protocol again. Run the panel 
if protocol located in a panel. Make 
sure the QC path is correct and the QC 
file being processed is located in this 
path.

H
Help is not available at this time No help screens are available yet. None. Informational only.

High channel value must not be 
smaller than Low Channel

System cannot accept a numeric 
region when the High channel value 
entered is smaller than the Low 
channel value.

Enter a value within the range 
indicated.

Host command invalid The Cytometer software could not 
process the requested command from 
the Workstation.

Record an entry into the instrument 
log.

I
I/O error [name] -- transaction rolled 
back

Watcom® SQL has detected a problem 
with your hard disk.

Check hard disk using the operating 
system or call your Coulter 
Representative.

ID must consist of 12 alphanumeric 
characters

System cannot accept the characters 
entered.

Enter a valid number consisting of 
alphanumeric characters.

Ignoring invalid regions When editing an equation, an invalid 
region has been entered.

Verify that the equation entered is the 
required equation.

Illegal Cytometer state Cytometer error. At the Workstation turn the system off, 
and then turn it back on.
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Initializing Empty Template Program did not find a template for 
this panel.

If this is a new template, just press 
Û to acknowledge the message.

If trying to load an existing template, 
try rebuilding the directory.

Insufficient memory available System needs more memory. At the Workstation turn the system off, 
and then turn it back on.

Insufficient memory for dialog box An internal error occurred. Exit SYSTEM II Software program and 
call your Coulter Representative.

Insufficient memory for listmode 
replay

System needs more memory to replay 
Listmode data

At the Workstation turn the system off, 
and then turn it back on.

Insufficient memory to load file System needs more memory to load 
Listmode data.

On the Utilities Configuration screen, 
toggle Color to off.

OR

In the Listmode/Protocol screen, 
reduce the histogram resolution.

OR

Add more memory to your computer.

Insufficient memory to load 
maintenance

The data located in the Maintenance 
screen could not be loaded from its file 
because there was not enough 
memory available.

Exit the SYSTEM II program and 
reboot the computer.

Insufficient space on [drive] : [number 
of bytes] bytes free! [number of bytes] 
bytes selected!

More space is needed on destination 
disk drive to copy or move files.

Remove files from the target drive.

Internal database error [name] 
--transaction rolled back

Watcom SQL detected a problem. Report this problem to Watcom and/or 
your Coulter Representative.

INTERNAL System ERROR: Invalid 
application specified

Software error. At the Workstation turn the system off, 
and then turn it back on.

Invalid count value You entered an invalid histogram stop 
count. 

Enter a valid stop count.

Invalid database engine command line It was not possible to start the 
database engine.

Executable file could not be found. 
Check environment variables.

Invalid equation string You entered an invalid histogram 
equation. 

Enter a valid histogram equation.

Invalid Loadlist Attributes changed in 
[panel name]

The Panel you want to continue has 
been modified.

Reload the Panel.

Invalid Loadlist Error accessing panel 
[panel name]

System could not open the specified 
panel.

From File menu, select Rebuild.

Invalid Loadlist Error opening panel 
[panel name]

File access error. From File menu, select Rebuild.
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Invalid Loadlist Panel size changed in 
[panel name]

The Panel size you want to continue 
has been modified (protocols have 
been added or deleted).

Reload the Panel.

Invalid Loadlist Protocol changed in 
[panel name]

The Panel you want to continue has 
been modified.  A protocol has been 
changed.

Reload the Panel.

Invalid Name.  Must be other than 
blank characters.

You entered a name consisting of 
blank spaces.

Enter another name.

Invalid operator id! Range: (A to Z) and 
(0 - 9)

System cannot accept the entered 
characters.

Enter a valid operator ID.

Invalid path selected System cannot process the entered 
path.

Enter a valid path.

Invalid region id The Region ID entered does not exist 
in the current protocol.

Specify a region that exists in the 
current protocol or create a new 
region.

Invalid region index. Call for service. Software error. At the Workstation turn the system off, 
and then turn it back on.

Invalid user id or password User has supplied an invalid user ID or 
password.

Enter a valid user ID or password.

Invalid value for column ‘[name]’ in 
table ‘[name]’

The specified value violates a CHECK 
constraint.

Enter the correct value.

L
Laser Current Error The amount of current required by the 

laser is outside the expected range.
Call your Coulter Representative.

Laser Current Okay The amount of current required by the 
laser was outside the expected range 
but is okay now.

Call your Coulter Representative.

Laser Power Error The amount of laser light power is 
outside the instrument’s operating 
range.

Call your Coulter Representative.

Laser Power Okay The amount of laser light power was 
outside the instrument’s operating 
range but is okay now.

Call your Coulter Representative.

Laser Regulation Warning The laser light power is fluctuating. Call your Coulter Representative.

Laser Start Error The laser failed to start within 120 
seconds.

Record an entry in the instrument log. 
Power the instrument off then on. If 
problem persists, call your Coulter 
Representative.

Last and only entry in <QC file name> 
was erased.  File was removed.  Erase 
corresponding entry in the QCS/QCC 
file.

After running an _A, _C, or _Q type 
protocol, the user erased the last entry 
after the protocol finished running.

This message tells the user that the QC 
file had only one entry and since it was 
erased, the QC file was deleted. For _A 
and _C erase the QCS file (baseline) 
and for _Q erase the QCC file.

Table 3.1  Error Messages (Continued)

Message Cause Action
PN 4237296CA 3-15



TROUBLESHOOTING
ERROR MESSAGES
LAST ENTRY ERASED IN [file name] Last entry in QC file has been erased. None.

Last entry in <QC file name> was 
erased. Erase corresponding entry in 
the QCS/QCC file.

After running an _A, _C or _Q type 
protocol, the user erased the last entry 
after the protocol finished running. 

Erase the corresponding entry in the 
matching QC file. For _A and _C erase 
the QCS file (baseline) and for _Q 
erase the QCC file.

Less than 1 megabyte of disk space 
available

Less than 1 megabyte of disk space 
available on C: drive.

Use archive, delete, or move on the 
Utilities Configuration screen and free 
up disk space.

Less than 4 megabytes of disk space 
available

There is a shortage of disk space 
available for saving new files for MCL 
run.

Use archive, delete, or move on the 
Utilities Configuration screen and free 
up disk space.

Less than 20 megabytes of disk space 
for MCL

There is a shortage of disk space 
available for saving new files for MCL 
run.

Use archive, delete, or move on the 
Utilities Configuration screen and free 
up disk space.

LISTMODE FILE NOT FOUND The system cannot find the selected 
Listmode file.

Specify the correct directories

OR

From File menu, select Rebuild.

Log file corrupted Log file for this database is corrupted. Delete the log file which pertains to 
this database.

M
Maximum is Eight Parameters The system cannot process more than 

eight parameters.
Select no more than eight parameters.

May NOT archive to a root directory The system cannot Archive to the root 
directory.

Change the archival directory.

MCL Carousel Homing Error Carousel did not go to home position. Check that there is no obvious 
obstructions (sample tube) in the MCL 
area. If no obstruction is found, call 
your Coulter Representative.

MCL Carousel In/Out Error Carousel did not move when requested 
to.

Check that there is no obvious 
obstructions (sample tube) in the MCL 
area. If no obstruction is found, call 
your Coulter Representative.

MCL Carousel Label Error MCL did not read carousel bar-code 
label.

Check that the bar-code label is not 
torn or written on. Try using another 
carousel. If problem persists, call your 
Coulter Representative.

MCL Carousel Rotate Error Carousel did not rotate correctly Check that there is no obvious 
obstructions (sample tube) in the MCL 
area. If no obstruction is found, call 
your Coulter Representative.

MCL CPU error MCL hardware error. Call your Coulter Representative.
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MCL Door Open Error

MCL Door Open Warning

MCL door is open while the MCL is in 
use.

Close MCL door.

MCL EPROM Error MCL hardware error. Call your Coulter Representative.

MCL Error MCL hardware error. Call your Coulter Representative.

MCL Interlock Error The MCL Interlock is open while the 
MCL is in use.

Call your Coulter Representative.

MCL Parallel Recv Error An MCL communications error. Call your Coulter Representative.

MCL Parallel Send Error An MCL communications error. Call your Coulter Representative.

MCL Probe Up/Down error MCL sample probe did not move when 
requested to.

Call your Coulter Representative.

MCL Program Load Error An MCL hardware error. Call your Coulter Representative.

MCL RAM Error An MCL hardware error. Call your Coulter Representative.

MCL Rec from Fault An MCL communications error. Call your Coulter Representative.

MCL Receive Timeout An MCL communication error. Call your Coulter Representative.

MCL Request Error Communication error between the 
Cytometer and the MCL.

Record an entry into the instrument 
log. Power the instrument off then on. 
If problem persists, call your Coulter 
Representative.

MCL Serial 1 Recv Error An MCL communications error. Call your Coulter Representative.

MCL Serial 1 Send Error An MCL communications error. Call your Coulter Representative.

MCL Serial 2 Recv Error An MCL communications error. Call your Coulter Representative.

MCL Serial 2 Send Error An MCL communications error. Call your Coulter Representative.

MCL Transmit Timeout An MCL communication error. Call your Coulter Representative.

MCL Tube Displaced Error Tube is positioned incorrectly. Call your Coulter Representative.

MCL Tube Jam Error Tube is stuck in the MCL. Call your Coulter Representative.

MCL Tube Load Error Bad seal between the MCL sample 
probe guide and sample tube.

Put sample in another tube.

MCL Tube Position Error MCL did not rotate to the correct tube 
position or there was an error reading 
the position bar code on the carousel.

Call your Coulter Representative.

MCL Tube Up/Down Error Unable to load or unload the sample 
tube from the MCL sampling position.

Check that the labels on the sample 
tubes are secure and are not adhering 
to the walls of the carousel. If problem 
continues, call your Coulter 
Representative.

MegaPanel cannot exceed 32 entries; 
Panel not copied.

The maximum number of protocols in 
a panel is 32.

Delete some protocols to avoid 
exceeding maximum number of 32.

Memory  unavailable Unable to allocate memory to allow 
export action to take place.

Exit SYSTEM II Software then restart 
program. If error persists, reboot 
Workstation.
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Missing Protocol(s). Panel is not 
loaded.

Protocols are missing from Panel 
being loaded.

Ensure all protocols are present in the 
panel/protocol directory.

Must be greater than previous level [n] You entered a smaller scaling value 
than the previous one.

Enter a larger scaling value.

Must enter RBC or WBC to save 
Hematology info

To save hematology information to the 
database, the RBC and WBC fields 
must not be empty.

Enter correct value.

Must first select a histogram to 
redisplay

You tried to redisplay an unspecified 
histogram.

Select a histogram first.

Must first select a histogram to rescale You tried to rescale an unspecified 
histogram.

Select a histogram first.

Must RESTART after cyto adjust. Run 
aborted

Adjustments were made without 
restarting Acquisition.

Current run is aborted.

1. Restart acquisition after making 
adjustments to the Cytometer.

2. Click on the RESTART button.

Must select panel to edit template! To edit a template, first select a 
panel/template.

Select a panel/template.

N
[Name] may NOT be selected Worklist megapanel may not be loaded 

directly.
Select Worklist.

[Name]’ is an unknown user id User has specified an unknown user 
ID.

Specify correct user ID.

Name must not consist entirely of 
spaces. DEFAULT is a reserved name.

The system cannot process a name 
consisting of blank spaces.

Enter another name.

Need a file name to save (Select ‘Save 
As’ for new file)

A new Worklist must be given a name 
when attempting to save.

Use the ‘Save As’ operation in order to 
assign a name to a new Worklist.

No available counters When trying to create a minimum 
counter, there were no spare counters 
available

Disable a histogram stop, time or 
volume stop.

No changes allowed while in Listmode You tried to make a change while in 
Listmode data analysis.

None. Informational only.

No disk space on this device Disk full or not accessible. Check device to see if media is write 
protected or media is missing.

No histograms were noted Protocol has missing histograms. Create histograms.

No listmode results to display You tried to display a histogram before 
replaying Listmode.

Replay the Listmode data first.

No more entries may be selected The maximum number of protocols in 
a panel is 32.

Delete some protocols to avoid 
exceeding maximum number of 32.

No more than 8 signals may be chosen 
as parameters.

You selected more than 8 signals as 
parameters.

Deselect some signals and then select 
others.

No more prism parameters can be 
assigned

The prism equation can only accept 4 
parameters.

Reduce the number of prism 
parameters to assign a new one.
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No parameter selected You tried to acquire data before 
selecting any parameters.

Select parameters first.

No reports queue has been selected. Queue has not been selected. Change directory or select a report.

No template possible for Loadlist A patient report template cannot be 
created for a Worklist which has more 
than one primary.

Define a patient report template for the 
individual panels in the Worklist.

No valid baseline file The QC baseline file (QCS) was not 
found.

Rerun _A protocol or QC panel to 
re-create QCS file.

The QC baseline file (QCS) required by 
the protocol does not exist.

Rerun the QC protocol. Run the QC 
panel if the protocol is located in a 
panel.  Make sure the QC path is 
correct and the QC file being 
processed is located in this path.

No valid histogram files were found You specified the wrong path

No directory files.

Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

No valid histograms were noted No histograms were detected in the 
current protocol.

Create new histograms.

No valid listmode files were found You specified the wrong path

No directory files.

Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

No valid protocol files were found You specified the wrong path

No directory files.

Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

No valid Specimen ID The system could not enter the 
Specimen ID into the database.

Enter a valid Specimen ID.

Not a valid region The system cannot accept a Quadstat 
region for the minimum event counter.

Select a linear, rectilinear, or an 
amorphous region.

Not connected to SQL database You have not connected correctly to 
the database.

Check environment and connect 
correctly.

Not enough memory to calculate 
amorphous statistics

System needs more memory to 
calculate the statistics for an 
amorphous region.

At the Workstation, turn the system 
off, and then turn it back on.

Not enough memory to start The database engine loaded, but there 
was not enough memory for it to run.

Free some conventional memory by 
unloading any non-XL programs that 
you have loaded into the MS-DOS 
operating system prior to starting the 
XL software.
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Not enough space for COPY There are insufficient data entry lines 
on the Worklist to copy the selected 
panel.

Ensure that the selected panel(s)’s 
protocols do not exceed the number of 
available data entry lines.

Not enough space for MOVE There are insufficient data entry lines 
on the Worklist to move the selected 
panel.

Ensure that the selected panel’s 
protocols do not exceed the number of 
available data entry lines.

Not enough space to add panel There are insufficient entry lines in 
Worklist for the selected panel to be 
added.

Ensure that the selected panel’s 
protocols do not exceed the number of 
available data entry lines. Add the 
panel to another area of Worklist or 
make room by rearranging the existing 
panels in the Worklist.

Not Yet Implemented An internal error has occurred. Exit SYSTEM II Software and call your 
Coulter Representative.

O
Only one more prism parameter can be 
assigned

The system can only accept 4 prism 
parameters. 3 are already assigned.

Assign one more parameter to prism 
or edit the current equation.

Operator ID: <operator ID> is already 
assigned

When assigning an operator ID to one 
of the operator ID boxes in the 
Maintenance screen (located to the 
right of the QC Maintenance table) one 
of these boxes already contained that 
ID.

Either assign a different operator ID or 
change the ID in the box that is in 
conflict with ID being assigned.

Out of MEMORY printing cytosettings SYSTEM II Software could not print 
the cytosettings due to insufficient 
memory.

Exit SYSTEM II Software and call your 
Coulter Representative.

Out of range The system cannot process the 
entered value.

Enter a value within the correct range.

Out of range: 0 - 9,999,999 The system cannot process the 
entered value.

Enter a value within specified range.

P
Panel contains deleted protocols or 
Error accessing panel file.

The selected panel contains the name 
of protocols that are not present under 
current directory path.

Edit the Panel to include Protocols in 
the current directory or copy the 
required protocols into the current 
directory.

Panel has auto setup protocols Panel contains protocols whose user 
name starts with an underscore “_”. 
These are protocols used for 
Autosetup and may not be run in a 
Worklist.

Select protocols that are NOT 
Autosetup. That is, they do not begin 
with an underscore “_”.

Panel has been modified since last 
MCL run

The system has detected a modified 
panel since the last MCL run.

The system restarts the panel from the 
beginning.

[Panel name]: Invalid panel selected You selected an invalid panel. From File menu, select Rebuild.
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[Panel name]: Invalid panel selected

[deleted protocol]: Protocol is deleted.

Occurs when a panel is selected and a 
protocol is missing from that panel.

Ensure that all protocols within the 
panel are present in the selected 
directory. 

Panel needs to be saved first When adding a panel to a panel, if the 
current panel on the screen has been 
modified but not saved, save the panel 
before adding to it.

When adding a panel to a panel, 
ensure that you save the current panel 
before adding another to it.

Panel was edited, save before exiting Occurs when the user attempts to exit 
the panel screen after modifying a 
panel but not saving it.

To save the changes to the panel, use 
Save to overwrite the current panel or 
Save As to save to a new panel. To 
restore the panel, select the Restore 
button at the bottom of the screen.

Panel: [panel name], NOT found The current panel file does not exist or 
is corrupted.

From File menu, select Rebuild, or 
select another file.

Parameters are not present Parameters are missing from protocol. Create the protocol again.

Parameters are not present, Carousel 
aborted on tube # [tube number]

Parameters are missing from the 
current loaded protocol in the panel.

Recreate the protocol.

Password was changed The user successfully changed the old 
supervisor password in the 
Maintenance screen for a new one.

None. Informational only.

Patient ID minimum of 5 characters The system is unable to accept a 
Patient ID that is less than 5 
characters.

Enter a Patient ID that is at least 5 
characters long.

Possible full disk Program cannot write information to 
file.

Specify the correct directories on the 
Utilities Configuration screen.

OR

Use archive on the Utilities 
Configuration screen and free up disk 
space.

Printer busy Printer is busy. Check Printer for error message.

OR

Wait.

OR

At the Workstation turn the system off, 
and then turn it back on.

Printer error Printer is out of order. Check Printer for error message.

OR

At the Workstation turn the system off, 
and then turn it back on.
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PRINTER NOT READY! Printer is not on-line or is out of paper. Put Printer on-line or add paper as 
needed. Check Printer for error 
message.

OR

At the Workstation turn the system off, 
and then turn it back on.

Printer out of paper Printer paper tray is empty. Add paper.

Prism parameters coexist. Dividers are 
set to lower letter regions

Two Quadstat regions have common 
parameter.

None.

Protocol not valid You created an invalid protocol. Create another protocol.

Q
QC Lot# could not be read from <QC 
file name>

The Lot# located in the header of the 
QC file being updated by the currently 
running protocol could not be opened.  
File was not found or was damaged.

Run the protocol again.  Run the panel 
if the protocol is located in a panel.  
Make sure the QC path is correct and 
the QC file being processed is located 
in this path.

<QC file name> was updated The named QC file was updated with 
the data as presented in the Data Table.  
All entries marked (yellow) or entries 
marked as deleted (purple) are also 
marked in the QC file.

N/A.

<QC file name> will be renamed to <QC 
file name>

This error message is due to a 
mismatch between the Lot #’s located 
in the QC protocol (a protocol with an 
underscore “_”) and its corresponding 
QC file. The message states that this 
file will be renamed to another name. 
The first file will then be reset and the 
Lot # from the protocol added to it. 
The results of the protocol run will 
then be added to this file. The renamed 
file will contain all the entries 
corresponding to the old Lot#.

Make a note for your records of the 
new name that the system gives the 
QC file. Be sure to record the Lot # 
corresponding to this QC file for future 
reference.

Quadstat regions not allowed in this 
equation

A quadstat region cannot be used as a 
gating region.

Refer to the Getting Started manual for 
more details on gating regions.

R
RAM memory is full No more RAM memory available to 

acquire more data.
On the Utilities Configuration screen, 
toggle Color to off.

OR

On the Protocol screen, reduce the 
histogram resolution.

OR

Add more memory to your computer.
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Read Cyto State timeout The Workstation timed out while 
waiting for the Cytometer to send state 
information.

Repeat operation. If error persists 
power OFF the Cytometer then restart 
the SYSTEM II Software program.

Rectilinear regions not allowed in 
prism equation

The system cannot assign a rectilinear 
region to a prism equation.

Change region type and re-create 
region to assign a region to a prism 
equation.

Region already erased You tried to erase a region that no 
longer exists.

Check cursor mode.

Region does not exist You are selecting a region that does 
not exist.

Select a region that exists.

Region undefined. May only edit 
defined regions.

You tried to edit an unspecified region. Create a region before edit.

Region with PRISM, TIME, AUX not 
allowed in prism

Parameter PRISM, TIME and AUX 
cannot be selected as a prism 
parameter.

Do not assign the region to prism 
equation.

Replay Not Active You pressed Ò during Listmode 
data analysis, but were not acquiring 
data.

None.

Replaying Data For Listmode Files 
Saved

Replaying the Listmode saved for post 
carousel report.

None.

Requested file does not exist in this 
directory

Program cannot find the file in the 
directory.

From File menu, select Rebuild.

Restarting MCL because: Did not find 
panel [panel file] in current directory

The MCL was not able to continue 
because the panel it ran last could not 
be found in the directory of the panel’s 
local path.

Rebuild panel directory before starting 
MCL.

Restarting MCL because Failed to 
access carousel file (entry [carousel 
entry num])

The MCL could not continue because 
the Carousel file could not be read or it 
was damaged.

Load the panel again and run using the 
MCL.

Restarting MCL because: Failed to 
access carousel file (entry 33)

The MCL could not continue because 
the last entry of Carousel file 
containing the panel name, could not 
be read.

Load the panel again and run using the 
MCL.

Restarting MCL because: Failed to get 
info about panel [panel file]

The MCL could not continue because 
the named panel could not be found.

Rebuild panel directory and load and 
run the panel again.

Restarting MCL because: Failed to 
open panel [panel file]

The MCL could not continue because 
the named panel although found could 
not be opened.

Rebuild panel directory and load and 
run the panel again.

Restarting MCL because: MCL/Panel 
attribute mismatch at entry [carousel 
entry num]

The MCL could not continue because 
the attributes of the protocol in the 
panel did not match the attributes of 
the corresponding protocol in the 
Carousel file at the given entry number.

The only choice is to reload the panel 
or run the panel from the beginning 
using the MCL.
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Restarting MCL because: MCL/Panel 
panel name mismatch at entry 
[carousel entry num]

The MCL could not continue because 
the panel name corresponding to the 
protocol at the given entry in the 
Carousel file is different from the 
corresponding entry in the panel file.

The only choice is to reload the panel 
or run the panel from the beginning 
using the MCL.

Restarting MCL because: MCL/ Panel 
protocol mismatch at entry [carousel 
entry num]

The MCL could not continue because 
the protocol name at the given entry in 
the Carousel file is different from the 
corresponding entry in the panel file.

The only choice is to reload the panel 
or run the panel from the beginning 
using the MCL.

Restarting MCL because: Num of 
protocols in [panel file] was changed

The MCL could not continue because 
the number of protocols recorded in 
Carousel file corresponding to the 
panel at the time it was run is different 
from the number of protocols in the 
panel as is now.

The only choice is to reload the panel 
or run the panel from the beginning 
using the MCL.

Run time SQL error -- [name] Watcom SQL has detected a problem. This problem should be reported to 
Watcom and/or your Coulter 
Representative.

S
Sample Pressure Error There may be a leak caused by a bad 

sample tube or a bad sample head.
Inspect sample tube and sample head 
for damage. Change as required. See 
Heading 2.8, Replacing the Sample 
Head.

Bad regulator or tubing. Call your Coulter Representative.

Sample Pressure Okay The sample pressure was outside the 
system’s operating range but is okay 
now.

None.

Sample pressure warning Sample tube not pressurized because 
it is bad.

Put sample into another tube.

Sample Stage Error The manual sample stage failed to 
move.

Call your Coulter Representative.

Sample Tube Error On Restart or Continue after Pause, the 
system could not sense a sample tube 
in the sample stage.

Reinsert the sample tube.

The system sensed a sample tube but 
after raising the sample stage it could 
no longer sense one.

Remove then reinsert the sample tube.

The system cannot run a cleanse cycle 
because there is a sample tube in the 
sample stage.

Remove the sample tube from the 
sample stage.
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Seek error [record #] or [offset #] Damaged QC file. Delete QC file and allow program to 
recreate it.

The record number located at the 
given offset could not be obtained.

Rerun the protocol. Run the panel if 
the protocol is located in a panel. Make 
sure the QC path is correct and the QC 
file is located in this path.

Selected panel not loaded into memory System was unable to load the 
selected panel in memory due to file 
access problems.

Rebuild your directory and try 
selecting the file again. If the error still 
occurs, you may have a corrupted file.

Selected Region is not in specified 
histogram

Selected region is not part of a 
histogram.

Call your Coulter Representative.

Selected signal cannot be a 
CALCULATED parameter

You tried to assign RATIO or TIME as 
the numerator or denominator for the 
RATIO parameter.

Select other signals.

Selected signal must be a parameter You tried to assign an unselected 
signal to the numerator or 
denominator for the RATIO parameter.

Select the signal as a parameter first.

Selection, edit or erase of ratio not 
allowed under listmode

You tried to select, edit, or erase the 
RATIO parameter while doing 
Listmode data analysis.

None.

Selection or erase of signals not 
allowed under listmode

You tried to select or erase parameters 
while doing Listmode data analysis.

None.

Sensor data stream error Data acquisition hardware error. Call your Coulter Representative.

Sensors Stream Warning There was an error in the 
communication of the instrument 
operating data packet from the 
acquisition hardware to the Cytometer 
software.

Record an entry into the instrument 
log.

Server/database engine version 
mismatch

Your version of the database server 
software is not compatible with your 
version of the database engine.

Load the correct client and server 
software combinations.

Set Idle Mode Cmd timeout The Workstation timed out while 
waiting for the Cytometer to enter idle 
state.

Repeat operation. If error persists, 
power OFF the Cytometer then restart 
the SYSTEM II Software program.

Set sample pressure fail Cytometer communication error. At the Workstation turn the system off, 
and then turn it back on.

Sheath Drawer Error Reagent drawer is open. Close reagent drawer completely.

Sheath Drawer Okay The drawer containing the sheath tank 
was open but now is closed.

None. Informational only.

Sheath Drawer Warning Reagent drawer is open. Close reagent drawer completely.

Sheath Level Error There is not enough sheath fluid for 
further sample analysis.

Fill sheath container.
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SHEATH LEVEL LOW! Add fluid. When 
cyto is READY, press Run

Low sheath fluid or sheath sensor 
failed.

Fill sheath container.

If the sheath container is full but the 
error still occurs, call your Coulter 
Representative.

Sheath Level Okay There was a sheath level warning or 
error, but the level is alright now.

None.

Sheath Level Warning The first time this message is 
displayed, there is enough sheath fluid 
for about 5 minutes of sample 
analysis.

Fill the sheath container. See Heading 
2.3, Filling the Sheath Fluid Container.

The second time this message is 
displayed, there is enough sheath fluid 
for about 4 minutes of sample 
analysis.

Sheath sensor failed. If the sheath fluid container is full but 
the error still occurs, call your Coulter 
Representative.

Sheath Pressure Error The sheath pressure was outside the 
system’s operating range.

Check sheath and cleanse tank caps 
for tightness. Call your Coulter 
Representative.

Sheath Pressure Okay The sheath pressure was outside the 
system’s operating range but is okay 
now.

Check sheath and cleanse tank caps 
for tightness. Call your Coulter 
Representative.

Sheath Pressure Warning Connectors on sheath container are 
loose.

Tighten connectors.

Sheath container cap loose Tighten cap.

Signal is already not used as a 
parameter

Signal is not being used. Check cursor mode and

select another signal.

Signal is already used as a parameter Signal is being used. Check cursor mode.

OR

Select another signal.

Skipping a queued file due to error Invalid file format. From the File menu, select Rebuild.

Skipping queued file [file name] due to 
error.

Erroneous entry detected while 
rebuilding and checking directory 
queue. The entry is automatically 
discarded.

None.

Software Failure Cytometer software failure. Record an entry in the instrument log. 
Power the instrument off then on.

Specified database is invalid The specified database is invalid. Specify the correct database. Check 
the environment.

Specified database not found The database engine was started but 
the database cannot be found.

Check the specified path of database 
or server.
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Specimen ID change NOT allowed Editing of Spec ID not allowed if call 
came from patient report pop-up.

Do not modify the specimen ID.

State Machine Failure Cytometer software failure. Record an entry in the instrument log. 
Power the instrument off then on.

Statement interrupted by user The user aborted a statement during 
its execution.

The database stops the command 
without doing a rollback.

String must be NUMERIC if longer 
than 8 characters

The tube ID consisted of more than 
eight alphanumeric characters.

Enter only numeric characters if tube 
ID is longer than 8 characters.

System Pressure Error Pressure line is not connected 
between the power module and the 
Cytometer.

Connect the power line.

The pressurized air supply is outside 
the system’s operating range.

1. Go to the Ready State, then check 
that the system pressure is 30 psi.

2. Run a sample and monitor the 
system pressure. If the system 
pressure drops below the range 
specified in the instrument manual, 
then call your Coulter 
Representative.

System Pressure Okay The pressurized air supply was outside 
the instrument’s operating range but is 
okay now.

1. Go to the Ready State by being in 
the Run mode and selecting a 
protocol or panel. Check that the 
system pressure is 30 psi.

2. Run a sample and monitor the 
system pressure. If the system 
pressure drops below the range 
specified in the instrument manual, 
then call your Coulter 
Representative.

System Pressure Warning Pressure is low. Check that:

1. WATER TRAP on front of Power 
Supply is tight.

2. Blue connectors on back of Power 
Supply and Cytometer are tight, 
and attached hose is intact.

3. No tubing is pinched.

System Vacuum Error Liquid in the vacuum trap. Check that the vacuum trap (on the 
front of the Power Supply) is tight and 
is less than 1/4 full of fluid. If it is more 
full, empty it (see Heading 1.8, 
Cleaning the VAC TRAP).

Vacuum line is not connected between 
the power module and the Cytometer.

Connect the vacuum line.

Hardware problem. Call your Coulter Representative. 
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System Vacuum Okay The vacuum supply was outside the 
instrument’s operating range but is 
okay now.

None.

T
TARGET HISTOGRAM INCOMPATIBLE When attempting to copy a region, the 

destination histogram is not 
compatible with the source histogram 
[number of parameters must be the 
same].

Ensure that the number of parameters 
in the destination histogram match the 
source histogram.

TARGET HISTOGRAM MUST BE 
DIFFERENT

You attempted to copy a region onto 
the same histogram.

Select a different histogram to be the 
destination histogram OR use the 
region create function to create 
another region on the same histogram.

Temperature Error Temperature inside Cytometer has 
risen above 60°C.

Clean your air filters. If problem 
continues, call your Coulter 
Representative. 

Temperature Okay The temperature inside the instrument 
went too high but now it is back in the 
normal range.

Call your Coulter Representative. 

Temperature Sensor Failure Temperature sensor failure. Call your Coulter Representative. 

Temperature Warning Temperature inside Cytometer is above 
50°C.

Clean your air filters. If problem 
continues, call your Coulter 
Representative. 

TERMINAL ERROR IN System! Press 
the Enter key to exit program.

Hardware failure. At the Workstation turn the system off, 
and then turn it back on.

Terminated by user -- transaction 
rolled back

The user aborted a command while the 
database was running.

A ROLLBACK WORK command is 
automatically executed by the 
database engine.

There are no saved key strokes to write 
to disk

You tried to save a macro, but there is 
nothing to save.

Create the macro again.

There are still active database 
connections

A database stop was requested while 
there are active connections.

Close down the connections and then 
stop the database.

There is no acquisition data to print You tried to print a histogram before 
acquiring any data.

Acquire data first.

There is presently no panel file to 
process

No panel files are available. Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

This report requires that COLOR be ON 
for your printer in the Utilities 
Configuration screen

This message occurs while in the 
Multigraph Overlay screen and a report 
is requested but the COLOR is OFF in 
the Utilities Configuration screen.

Select the Utilities screen and change 
the color option for your printer.
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To cont. MCL wait for msg 

-Insert Sample Tube-, press AUTO

After sheath low or waste full, this 
message appears.

Follow instructions on message

To use ‘Save’ a protocol must be 
loaded

An attempt was made to save a QC 
template but no protocol was selected 
first. A protocol must be selected so 
that if you select Save from the File 
pull-down menu, the system can 
create the corresponding QC template.

Select a protocol by activating Select 
from the File pull-down menu located 
in the QC Template screen.

To use ‘Save As’ a protocol must be 
loaded

An attempt was made to save a QC 
template to a new QC template file 
before you selected a protocol. Select 
a protocol first to identify the source 
QC template file to the system. To copy 
the currently loaded protocol to a new 
protocol, select Save As from the File 
pull-down menu. This also copies the 
current QC template to a QC template 
file for the new protocol.

Select a protocol by activating Select 
from the File pull-down menu located 
in the QC Template screen.

Too many connections to database You have exceeded the maximum 
number of users.

Acquire a license for more users.

Too many prism parameters entered They system can only accept up to 4 
prism parameters.

Reassign prism equations.

Too many Protocols in Panel You cannot edit a panel which has 
more than 32 protocols.

Reduce the number of protocols to 32 
or less.

Too many regions used for gating The histogram builder has reached its 
limit for gating and minimum counter 
regions.

Either do not use a minimum counter, 
or eliminate a gating region.

Transmit time-out The export process timed out waiting 
for COM port to become available for 
next transmission.

Ensure sending and receiving baud 
rates match. Make sure cables are 
properly connected.

Transputer 1 error

Transputer 2 error

Cytometer software error. At the Workstation turn the system off, 
and then turn it back on.

Transputer Link Error A cytometer computer 
communications error.

Call your Coulter Representative.

Transputer Link Failure A cytometer computer 
communications error.

Call your Coulter Representative.

Transputer Link Okay A cytometer computer 
communications error.

Call your Coulter Representative.

Tube ID already assigned The assigned tube ID already exists in 
Worklist.

Enter a tube ID that is not already 
assigned to a protocol in Worklist.
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Tube ID does not match barcode. MCL 
will be stopped.

While running a Worklist using the 
MCL the tube ID assigned to the 
current protocol did not match the 
barcode attached to the tube being 
processed.

Inspect the MCL and make sure that 
each tube barcode matches its 
corresponding tube ID in the Worklist.

U
Unable to access file. SYSTEM II Software was unable to 

access a file.
Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

Unable to access file [file name] Error reading current panel file. Exit SYSTEM II Software then restart 
program. If error persists, reboot 
Workstation.

Unable to access file [protocol name] Program cannot load the named 
protocol file, or the named file is 
invalid.

Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

Unable to activate mouse Mouse graphics driver not activated - 
missing mouse driver or mouse.

Check MS-DOS® system configuration 
to set mouse driver and test mouse 
before running program.

Unable to allocate memory This message appears when a report is 
requested or switching to the 
Histogram Data screen, but there is 
insufficient memory to perform the 
operation.

Exit SYSTEM II Software and restart it. 
Enter the Multigraph application and 
retry the operation.  If this still does 
not work, call your Coulter 
Representative.

Unable to allocate protocol memory This message occurs during 
Multigraph initialization and there is 
insufficient memory for Multigraph to 
operate correctly.

Exit SYSTEM II Software and restart it.  
Enter the Multigraph application. If this 
still does not work, call your Coulter 
Representative.

Unable to assign histogram memory This message occurs during 
Multigraph initialization and there is an 
internal error initializing the memory 
used for histograms.

Exit SYSTEM II Software and restart it. 
Enter the Multigraph application. If this 
still does not work, call your Coulter 
Representative.

Unable to autogate  Not enough data points inside the gate. 
Unable to identify a distinct population.

Run the sample again.

OR

Redraw the region.

Unable to change histogram display An internal error has occurred in the 
Multigraph histogram display.

Exit SYSTEM II Software and restart it.  
Enter the Multigraph application. If this 
still does not work, call your Coulter 
Representative.

Table 3.1  Error Messages (Continued)
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UNABLE TO COPY - MAXIMUM 
NUMBER OF AMORPHOUS REGIONS

When copying an amorphous region, 
the system is unable to complete the 
task since the protocol already has the 
maximum number of eight amorphous 
regions allowed.

Try deleting some amorphous regions 
before assigning new ones.

Unable to create the histogram queue SYSTEM II Software was unable to 
create a histogram queue.

Ensure the disk where your 
histograms are located is not write 
protected. Also, check for a possible 
disk full condition.

Unable to create the regions display There is insufficient memory to 
process the histogram in Multigraph 
single histogram display.

Exit SYSTEM II Software and restart it.  
Enter the Multigraph application. If this 
still does not work, call your Coulter 
Representative.

Unable to find/open the protocol file File deleted. Recreate the protocol.

OR

Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

Unable to find the Listmode file Program cannot access Listmode file. From File menu, select Rebuild.

Unable to find the Listmode file, 
Carousel aborted on tube # [tube 
number]

Program cannot access Listmode file. From File menu, select Rebuild.

Unable to find the Listmode file, 
Current operation aborted

Program cannot access Listmode file. From File menu, select Rebuild.

Unable to find the panel info You pressed È or Ê during panel 
selection. Panel file cannot be found.

Select panel again.

OR

Specify the correct directories on the 
Utilities Configuration screen.

Unable to get the available disk space Program cannot calculate the available 
disk space.

At the Workstation, turn the system 
off, and then turn it back on.

Unable to get the specified Cytometer 
state

Cytometer failed. Call your Coulter Representative.

Unable to initialize histogram memory An internal error was detected on 
initializing the memory required for 
histograms in Multigraph.

Exit SYSTEM II Software and restart it. 
Enter the Multigraph application. If this 
still does not work, call your Coulter 
Representative.

Unable to initialize protocol memory An internal error was detected on 
initializing the memory used for 
histograms in Multigraph.

Exit SYSTEM II Software and restart it. 
Enter the Multigraph application. If this 
still does not work, call your Coulter 
Representative.

Unable to load current panel Panel file is corrupted and cannot be 
opened.

Re-create the panel or select another 
panel.

Table 3.1  Error Messages (Continued)
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Unable to load hematology info from 
database

Loading hematology information from 
database failed.

Check Hematology ID in database is 
same as Specimen ID.

UNABLE TO LOAD LISTMODE FILE Wrong types of data file, or corrupted 
file.

Select another Listmode file.

Unable to load panel Panel file is corrupted and cannot be 
opened.

Re-create Panel or select another 
panel.

Unable to load patient info from 
database

Loading patient information from 
database failed.

Check Patient ID in database.

Unable to load queue file File load error, no queue file. You 
specified a wrong path.

Specify the correct directory on the 
Utilities Configuration screen

OR

From File menu, select Rebuild.

Unable to load specimen info from 
database

Loading specimen information from 
database failed.

Check Specimen ID.

Unable to load this protocol version Protocol incompatible with current 
program.

Re-create the protocol with current 
program.

Unable to open current panel Unable to open the current panel. Rebuild the directory and reselect the 
panel.  If unable to re-select, call your 
Coulter Representative.

Unable to open file Error opening file for export. Repeat export operation. If error 
persists, exit SYSTEM II Software and 
reset Workstation.

Unable to open file for processing File load error. Specify the correct directories on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

Unable to open Listmode work file You specified wrong path. Specify the correct directories on the 
Utilities Configuration screen.

Unable to open matching QCS file This message occurs when a QCC file 
is loaded but no matching QCS file is 
found.

Create the QCS file by running the _A 
protocol whose xyz prefix matches 
that of the _Q protocol which created 
the QCC file.

Unable to open QCC (or QCS) file An attempt was made to open a QCC 
(or QCS) file that is nonexistent or 
damaged.

Make sure the QC path is correct and 
the QC file being accessed is located in 
this path.

Unable to load QC Template file related 
to this protocol

A protocol was selected that did not 
have a matching template file.

In the Template screen, select the 
protocol and create a template. Then 
select Save from the File pull-down 
menu. This creates a template 
matching the selected protocol.

Unable to open Panel file Panel file is corrupted and cannot be 
opened.

Recreate the panel or select another 
panel.

Table 3.1  Error Messages (Continued)
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ERROR MESSAGES 3
Unable to open template file File load error. Specify the correct directory on the 
Utilities Configuration screen.

OR

From File menu, select Rebuild.

Unable to print with no histograms This message is displayed when there 
are no histograms for printing.

Select histogram to print, if none 
create histograms in Listmode replay.

UNABLE TO PROCESS [file name] QC file not found. Rerun QC panel to create QC file.

Unable to Process <QC file name> When erasing the last entry from a QC 
file after running an _A, _C, or _Q 
protocol, the file was lost or damaged.

Run the protocol again. Run the panel 
if protocol located in a panel. Make 
sure the QC path is correct and the QC 
file being processed is located in this 
path.

Unable to read file Error occurred while reading file being 
exported.

Retry export operation. If error 
persists, exit SYSTEM II Software and 
reset Workstation. If no change, file 
may be damaged.

Unable to read header Panel file is corrupted and cannot be 
opened.

Recreate the panel or select another 
panel.

Unable to read non-XL protocols You tried to load a non-XL program 
protocol.

Do not load any non-XL protocols.

Unable to reset Cytometer--reboot Cytometer cannot be reset with the 
RESET button.

At the Workstation turn the system off, 
and then turn it back on.

Unable to save - Protocol not loaded Unable to perform save because no 
protocol has been loaded.

Load or create a protocol.

Unable to save histogram [n] error [m] This message is displayed when 
saving the histograms in the working 
set. ‘n’ is the number of the histogram 
in working set and ‘m’ is the error 
code.

Ensure the disk containing your 
histograms is not write protected. 
Also, check for a possible disk full 
condition.

Unable to save protocol file You specified wrong path. Specify the correct directories on the 
Utilities Configuration screen.

Disk full. Use archive on the Utilities 
Configuration screen and free up disk 
space.

Unable to save protocol file Carousel 
aborted on tube # [tube number]

You specified wrong path. Specify the correct directories on the 
Utilities Configuration screen.

Disk full. Use archive on the Utilities 
Configuration screen and free up disk 
space.

Table 3.1  Error Messages (Continued)
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Unable to save protocol file Current 
operation aborted

You specified wrong path. Specify the correct directories on the 
Utilities Configuration screen.

Disk full. Use archive on the Utilities 
Configuration screen and free up disk 
space.

Unable to save protocol with no 
histograms

The system cannot save a Protocol 
with no histograms

Create histograms before saving the 
protocol.

Unable to save template Error occurred during the saving of a 
template.

Ensure template was created. Repeat 
operation.

Unable to set Cytometer in the READY 
to ACQUIRE state

Cytometer failed. See Heading 2.11, Resetting the Circuit 
Breakers. 

Unable to start database engine It was not possible to start the 
database engine.

Executable file could not be found. 
Check environment variables.

Unable to start specified database It was not possible to start the 
database engine.

Executable file could not be found. 
Check environment variables.

Unable to write PCX file The system cannot access the 
specified path.  Disk full.

Specify the correct directory. Use 
archive on the Utilities Configuration 
screen and free up disk space.

Unknown data stream error

Unknown data stream warning

Data acquisition hardware error. Call your Coulter Representative. 

Unknown error System unable to program Cytometer. At the Workstation turn the system off, 
and then turn it back on.

Unknown file type This file may not be exported. Select correct file type for export.

Unknown region type. Call for service. Unknown region types. Call your Coulter Representative. 

Unknown Stream Warning An unidentified data packet 
communication error occurred 
between the Cytometer hardware and 
software.

Record an entry into the instrument 
log.

Use  Ë from run screen to print for 
special analyses

The System cannot replay listmode 
data with Cell Stat or Retic Stat prior to 
Alt-Save/Print Histogram option.

Do not highlight the option on the 
Alt-Save box. Instead, use Ë after 
exiting the Alt-Save box.

V
Vacuum Chamber Error

Vacuum Chamber Warning

Liquid level in vacuum chamber is too 
high.

Use the cleaning tube adapter.

Valid display angle range is 0 to 360 The system cannot process the 
entered display angle.

Enter a value between 0 and 360.

Valid range is [.] The system cannot process the 
entered numeric value.

Enter a value within a specified range.

Values allowed: [valid range] The system cannot process the 
entered value.

Enter a value within the specified 
range.

Table 3.1  Error Messages (Continued)
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VDI display device driver not loaded 
properly.

No VDI graphics are loaded. Put the software program diskette in 
drive A.

At the A:\ prompt, type install.

W
Warning: Less than 4 megabytes of 
disk space available

Less than 4 MB is free on the hard 
disk.

Use archive on the Utilities 
Configuration screen and free up disk 
space.

Warning: Less than 1 megabyte of disk 
space available

Less than 1 MB is free on the hard 
disk.

Use archive on the Utilities 
Configuration screen and free up disk 
space.

Warning: No valid histograms were 
noted

You created a protocol with no 
histograms.

You created histograms that do not 
match the gates you created.

Create another protocol.

Warning: No valid signals were noted The protocol (in Listmode data 
analysis) does not match the signal.

Create or select another protocol.

OR

Select another Listmode file.

Waste Backpressure Error The filter on the waste tank vent line is 
probably wet or clogged or 
disconnected.

Check waste vent filter for presence of 
liquid and proper connection. Call your 
Coulter Representative.

Waste Backpressure Okay There was too much pressure in the 
waste tank but it is okay now.

None.

Waste Level Error There is not enough empty volume in 
the waste tank for further sample 
analysis.

Empty the waste container.

WASTE LEVEL FULL! Empty tank. 
When cyto is READY, press RUN

Waste container is full. Waste sensor 
failed.

Empty the waste container. If the waste 
container is not full and this error 
appears, call your Coulter 
Representative.

Waste Level Okay Waste tank for is back to normal from 
a waste level warning or error state.

None. Informational only.

Waste Level Warning There is enough empty volume in the 
waste tank for about 5 minutes of 
sample analysis.

Empty waste tank.

Waste sensor failed. If the waste tank is not full when this 
error message appears, call your 
Coulter Representative.

Worklist file not found The given Worklist file was not found 
at the directory paths as given in the 
Utilities Data Management screen.

Ensure the directory paths are correct 
and repeat the operation.

Worklist type panel may not be edited Tried to select ‘Current Worklist’ Panel 
from the Select menu.

Do not select Worklist type panel.

Table 3.1  Error Messages (Continued)
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Wrong Date format or out of range When entering the date, either an 
illegal date was entered or the format 
was not as DDMMMYY (for example, 
12Apr98).

Enter correct format and make sure 
the day does not exceed max month 
day.

Wrong file An error has occurred accessing the 
selected configuration.

Rebuild configuration directory and 
retry selecting the configuration file. If 
unsuccessful, call your Coulter 
Representative.

Wrong password When trying to activate the Supervisor 
ID box on the QC Maintenance screen, 
the user has entered the wrong 
supervisor password.

Enter the correct password.  If 
supervisor is unable to reproduce the 
correct password then the Master 
Password must be used. This 
password should be in possession of 
an authorized person.

Wrong Time format or out of range The system cannot process the Time 
value entered.

Enter a valid time.

X
X and y channel count exceeded 65535 Count too high when calculating a 

projection.
Statistics are invalid

X channel count exceeded 65535 Count too high when calculating a 
projection.

Statistics are invalid.

Y
Y channel count exceeded 65535 Count too high when calculating a 

projection.
Statistics are invalid.

You cannot delete the next use entry The system cannot delete the ‘Next’ 
used entry from a queue.

To delete that entry, reassign the ‘Next’ 
to another entry and then delete.

You cannot deselect the next use entry The system cannot deselect the ‘Next’ 
used entry.

To deselect the ‘Next’ entry, reassign 
‘Next’ first.

You may not make a deleted or errored 
entry as next

The system can assign ‘Next’ to a 
deleted protocol.

Do not assign ‘Next’ to a deleted 
protocol.

The system cannot assign a deleted or 
corrupted protocol as ‘Next’.

Reassign ‘Next’.

You must select a protocol. You must first select a protocol to edit 
this column.

Select a protocol in the 
protocol/equation column.

Z
Zero length file File is empty. Ensure file for export contains data.
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A
ABAR-CODE OPTIONS

A.1 BAR-CODE READER

A.2 BAR-CODE PRINTER

An optional hand held bar-code reader is 
available for your system. Refer to the 
bar-code reader manufacturer’s manual 
for specific instructions about using it.

The illustration to the right shows how to 
connect the bar-code reader to your 
system.

To keyboard
connection on
back of computer.

7296006A

An optional bar-code printer is available 
for your system. Refer to the printer 
manufacturer’s manual for specific 
instructions about using it.

The illustration to the right shows how to 
connect the bar-code printer to your 
system.
PN 4237296CA A-1



BAR-CODE OPTIONS
BAR-CODE PRINTER
Bar-Code Printer Switch Settings

The illustration to the right shows how to 
set the bar-code printer switch settings 
for use with your system.

(L)
ON

(R)
OFF

1
2

3
4

5
6

7
8

7296008A
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BQC MAINTENANCE SCREEN

B.1 WORKING WITH THE QC MAINTENANCE SCREEN
This screen maintains a dated maintenance log for your records, including the operator ID 
symbol for each of the listed actions.

Use the QC Maintenance screen to record:

 r Daily start up actions

 r Daily shutdown actions

 r Cleaning procedures

 r Replacement procedures

 r Adjustment procedures.

On the day you perform one of the above actions, enter your operator ID symbol next to the 
maintenance action you performed. Assign and use a different operator ID symbol to each 
operator for your record keeping.

A supervisor can edit any entry made in the QC Maintenance screen.

Accessing the Screen
To open the QC Maintenance screen:

Applications tt QC.

Screen tt Maintenance.

7296009B
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QC MAINTENANCE SCREEN
EDITING THE MAINTENANCE SCREEN (OPERATOR LEVEL)
Printing the Screen
If you want to print the screen for your laboratory records:

File tt Print.

B.2 EDITING THE MAINTENANCE SCREEN (OPERATOR LEVEL)

Assigning An Operator ID To A Colored Box
You need to assign your operator ID to one of the colored boxes at the right of the screen 
before you can edit the QC Maintenance screen. Nine different operators plus the supervisor 
can be defined in the system at the same time. Once assigned, your operator ID always 
appears in the same colored box until changed.

To assign your operator ID to a colored box so you enter the corresponding symbol when you 
record a maintenance action performed:

1. If you have not already entered your 
operator ID into the software:

Click on the OPERATOR ID
field at the top of the screen.

Type in your operator ID.

2. After your operator ID is in the 
system:

Click on an empty colored box
at the right of the screen.

3. The current operator ID 
automatically appears in the box.

Whenever you click in a square in 
the QC Maintenance screen, the 
matching color and symbol of the 
box for the current operator ID 
appears in the square on the screen.

7296011B

7296014B
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QC MAINTENANCE SCREEN
EDITING THE MAINTENANCE SCREEN (OPERATOR LEVEL) B
Making an Entry

Erasing an Entry

1. Click on the colored box with
your operator ID in it.

2. Click on the square for each
action completed today. Your
color and symbol appear in
each selected square.

Note: Only a supervisor can make 
entries on prior days.

3. For System Pressure and System 
Vacuum:

Click on the square for each
action completed today. 

Type in the number of the 
instrument reading.

7296014B

1. Click on the colored box with
your operator ID in it.

2. Click on the Erase box.

3. Click on any of today’s entries
that you want to erase.

Note: Only a supervisor can erase 
entries on prior days.

7296014B

7296012B
PN 4237296CA B-3



QC MAINTENANCE SCREEN
EDITING THE MAINTENANCE SCREEN (SUPERVISOR LEVEL)
B.3 EDITING THE MAINTENANCE SCREEN (SUPERVISOR LEVEL)
Only a supervisor can:

 r Make an entry on a day prior to today.

 r Erase entries made on a day prior to today.

Making Or Deleting An Entry

1. Click on the black SUPVR box.

2. Type in your password at the system 
prompt and press Û.

3. Use the scroll bar at the bottom of 
the screen to access the day needed.

4. To make an entry:

Click on the square for each
action completed for that day.
An S in a black background
appears in each selected square.

To delete an entry:

Click on a square a second time
and the S just entered changes
to “-” in the square.

7296013B

7296015B
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QC MAINTENANCE SCREEN
CHANGING THE PASSWORD (SUPERVISOR LEVEL) B
B.4 CHANGING THE PASSWORD (SUPERVISOR LEVEL)

1. Click on the SUPVR box with
the right mouse button.

2. Type in your OLD (current) 
password at the system prompt and 
press Û.

When doing this for the first time 
after system installation there is no 
OLD password. Simply press Û.

3. Type in your NEW password at the 
system prompt and press Û.

4. Type in your NEW password again 
at the system prompt and press Û 
to confirm your new password.

The new password is now valid.

7296013B

7296016B

7296017B

7296018B
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CHANGING THE PASSWORD (SUPERVISOR LEVEL)
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Symbols
%Lymph + %Mono +%Gran + %Blast > 100.0, 3-3

A
A region must first be selected, 3-3
adaptor, cleaning

how to use, 1-24, 1-25
adjustment procedures, 2-1

circuit breakers, resetting, 2-22
neutral density (ND1) filter, positioning, 2-20
record on Maintenance screen, B-1
system pressure, 2-18

air bubbles, venting, 2-5, 2-14
air filters

See filters, 1-1
All other errors, 3-3
All regions are already assigned, 3-3
Allowable levels

8 to 65535 or 0 for AUTO, 3-3
Amorphous regions not allowed in prism 

equation, 3-3
An empty string is not a valid password, 3-3
An internal error has occurred, 3-4
Analysis date earlier than DOB, 3-3
Analysis date-time earlier than Collection 

date-time, 3-3
Apparent File Load Error, 3-4
Autosetup Cycle Terminated, 3-4

B
Bar Code Printer NOT present or wrong type, 3-4
bar-code printer

connection, A-1
illustration, A-1
switch settings, A-2

bar-code scanner/reader
connection, A-1
illustration, A-1

bleaching
routine cleaning, auto mode, 1-21
routine cleaning, manual mode, 1-19

bubbles
venting, 2-5

buttons
vent, 2-5

C
Calibrator Region already exists, 3-4
Cannot assign CALIBRATOR to a Quadstat, 3-4
Cannot find this region, 3-4
Cannot get Cytometer ready, 3-5
Cannot get sample information from MCL, 3-5
Cannot open protocol queue file, 3-5
Carousel completed ... cannot continue, 3-5
Carousel restart error, 3-5
Caution

No histograms were noted, 3-5
changed, 3-24
Channel overflow condition exists, 3-5
circuit breakers

resetting, 2-22
cleaning adaptor

how to use, 1-24, 1-25
cleaning agent

container, cleaning, 1-9
container, filling, 2-7

cleaning agent container
cleaning, 1-9
fillling, 2-7

cleaning procedures, 1-1
air filters, 1-1
bleaching, 1-18
cleaning agent container, 1-9
record on Maintenance screen, B-1
routine, 1-18
sample head, 1-22, 1-23
sample probe, 1-22, 1-23
sampling system, when to clean, 1-18
sheath fluid, 1-7
vacuum line, 1-24, 1-25
vacuum trap, 1-12

cleanse cycle, 1-24, 1-25
Cleanse Level Error, 3-5
Cleanse Level Okay, 3-5
Cleanse Level Warning, 3-5
cleanse low indicator, 3-1

what to do when red, 3-1
Client/server communications protocol 

mismatch, 3-5
Collection date earlier than DOB, 3-5
Com. Port unavailable, 3-5
Comm. complete, 3-5
Communication error, 3-6
Confirmation failed, 3-6
Connection not found, 3-6
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INDEX
Connections to database have been disabled, 3-6
container, reagent

replacing, 1-11
container, waste

replacing, 2-10
containers, replacing

reagent, 1-11
conventions

used in the manual,  x
Counter not available, 3-5, 3-6
Current Worklist may NOT be selected, 3-6
Cyto_change_error, 3-6
Cytometer communications failure during file 

load, 3-6
Cytometer error, 3-6
Cytometer program file not found, 3-6
Cytometer read cyto state timeout, 3-7

D
daily

routine cleaning, 1-18
vacuum line cleaning, 1-24

Data Memory Problem, 3-7
Data rate error, 3-7
Data Rate Warning, 3-7
Data Stream Error, 3-7
Data Stream Okay, 3-7
Data Stream Warning, 3-7
Database engine not running, 3-7
Database engine not running in multi-user 

mode, 3-7
Database name required to start engine, 3-7
Database was initialized with an older version of the 

software, 3-7
Dblib/database engine version mismatch, 3-7
DEFAULT is a reserved name, 3-7
Disk full -- transaction rolled back, 3-7
documentation for your instrument

about your special procedures and 
troubleshooting manual,  ix

conventions used,  x
icons, description,  x
introduction to your manuals,  ix
symbols, meaning,  x
using the manuals,  ix

does NOT exist, 3-12
does not exist in this directory!, 3-13
Crit, 3-6
Insufficient space on, 3-14

due to error., 3-26
Duplicate entry not possible, 3-7

E
emptying waste container, 2-10
Equation(s) exceed defined limitations, 3-8
err Reading | Writing, 3-6
ERROR

2 parameter histograms not allowed, 3-8
Channel resolution of histograms are 

different, 3-8
Histogram Log decades are different, 3-8
Mouse Driver Not Present, 3-11
No more entries may be selected, 3-11
Not enough memory to calculate amorphous 

statistics, 3-11
Unable to receive cytometer's program 

version, 3-11
Error

Invalid path selected, 3-10
Error accessing panel file, 3-8
Error accessing password, 3-8
Error allocating extended memory, 3-8
Error building WorkList panel, 3-8
Error creating WorkList Loadlist, 3-8
Error forming queue, 3-8
Error in acquiring, 3-8
Error in entry, 3-8
Error in equation, 3-8
ERROR IN LOADING DATA, 3-8
Error in loading protocol, 3-9
Error in rename listmode file, 3-9
Error in sending all signals selected as parameters 

during acq, 3-9
Error in sending all the compensation values of the 

signals, 3-9
Error in sending all the gain settings to 

Cytometer, 3-9
Error in sending all the pertinent time parameters to 

Cytometer, 3-9
Error in sending compensation to Cytometer, 3-9
Error in sending discriminators to Cytometer, 3-9
Error in sending ratio's numerator and denominator 

to Cytometer, 3-9
Error in sending sample pressure, 3-9
Error in sending signal with the discriminator 

set, 3-9
Error in sending signals to Cytometer, 3-9
Error in setting Cytometer in the awaiting sample 
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INDEX
state, 3-9
Error in writing file, 3-10
Error in writing file, Current operation 

aborted, 3-10
Error initializing protocol, 3-10
Error installing clock interrupt vector, 3-10
Error installing Cytometer interrupt vector, 3-10
Error loading cytometer program file, 3-10
Error loading file, 3-10
ERROR LOADING LISTMODE FILE, 3-10
ERROR LOADING PROTOCOL, 3-10
error messages

list of, 3-3
log, description, 3-2
log, screen, 3-2

Error reading Carousel file, 3-11
Error saving file, 3-11
Error stop Cytometer, 3-11
Crit Non Disk err

, 3-6
Error validating your entry, 3-12
Error writing to log file, 3-12
ERROR!  does not exist in this directory!, 3-8
ERROR! -- Unable to read non-XL protocols!, 3-11
ERROR! DEFAULT is a reserved name, 3-8
ERROR! Name must not consist entirely of 

spaces, 3-11
ERROR! Possible full disk, 3-11
ERROR! Requested file does not exist in this 

directory, 3-11
ERROR! Unable to access file, 3-11, 3-11
ERROR! Unable to get available disk space for 

specified drive, 3-11

F
Use, 3-34
Fail to close Listmode file, 3-12
Fail to close Listmode file, Current operation 

aborted, 3-12
Failed to read MCL state, 3-12
Failed to update password, 3-12
Restarting MCL because

Failed to get info about panel, 3-23
Failed to open panel, 3-23

File larger than 32768 bytes, 3-13
ERROR writing to file, 3-12
File Write Error, 3-13
LAST ENTRY ERASED IN, 3-16
Skipping queued file, 3-26

Unable to access file, 3-30
UNABLE TO PROCESS, 3-33
File name is, 3-13
File problem, 3-13
File Write Error -, 3-13
, 3-12, 3-13
FILE, 3-13
filters

air, cleaning, 1-1
air, location, 1-1
neutral density (ND1) filter, positioning, 2-20
sheath, replacing, 2-13

Fm__system not allocated, 3-12
from run screen to print for special analysis, 3-34

H
hand held scanner/reader

See bar-code scanner/reader, A-1
handler, 3-10
Help is not available at this time, 3-13
Error installing interrupt, 3-10
High channel value must not be smaller than Low 

Channel, 3-13
Host command invalid, 3-13

I
icons used in the manual,  x
ID must consist of 12 alphanumeric 

characters, 3-13
idle mode, 1-4
Ignoring invalid regions, 3-13
Illegal Cytometer state, 3-13
indicators, level sense, 3-1
Initializing Empty Template, 3-14
Insufficient memory available, 3-14
Insufficient memory for dialog box, 3-14
Insufficient memory for listmode replay, 3-14
Insufficient memory to load file, 3-14
Insufficient memory to load maintenance, 3-14
INTERNAL System ERROR

Invalid application specified, 3-14
introduction to your manuals,  ix
Invalid count value, 3-14
Invalid database engine command line, 3-14
Invalid equation string, 3-14
Invalid Name. Must be other than blank 

characters., 3-15
Invalid operator id! Range
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(A to Z) and (0 - 9), 3-15
Invalid path selected, 3-15
Invalid region id, 3-15
Invalid region index. Call for service., 3-15
Invalid user id or password, 3-15
is an unknown user id, 3-18

L
Laser Current Error, 3-15
Laser Current Okay, 3-15
Laser Power Error, 3-15
Laser Power Okay, 3-15
Laser Regulation Warning, 3-15
Laser Start Error, 3-15
Last and only entry in  erased. File removed., 3-15
Last entry in  erased. Erase entry in QCS/QCC 

file, 3-16
Less than 1 megabyte of disk space available, 3-16
Less than 20 megabytes of disk space for MCL, 3-16
Less than 4 megabytes of disk space available, 3-16
level sense indicators, 3-1

cleanse low, 3-1
sheath low, 3-1
waste full, 3-1

LISTMODE FILE NOT FOUND, 3-16
Log file corrupted, 3-16
log sheets

error messages, 3-2
QC Maintenance screen, B-1

M
error, 3-33
Maintenance screen

See QC Maintenance screen, B-1
manuals for your instrument

conventions used,  x
how to use,  ix
icons, description,  x
introduction to your manuals,  ix
symbols, meaning,  x
using the manuals,  ix

Maximum is Eight Parameters, 3-16
May NOT archive to a root directory, 3-16
may NOT be selected, 3-18
MCL Carousel Homing Error, 3-16
MCL Carousel In/Out Error, 3-16
MCL Carousel Label Error, 3-16
MCL Carousel Rotate Error, 3-16

MCL CPU error, 3-16
MCL Door Open Error, 3-17
MCL Door Open Warning, 3-17
MCL EPROM Error, 3-17
MCL Error, 3-17
MCL Interlock Error, 3-17
MCL Parallel Recv Error, 3-17
MCL Parallel Send Error, 3-17
MCL Probe Up/Down error, 3-17
MCL Program Load Error, 3-17
MCL RAM Error, 3-17
MCL Rec from Fault, 3-17
MCL Receive Timeout, 3-17
MCL Request Error, 3-17
MCL Serial 1 Recv Error, 3-17
MCL Serial 1 Send Error, 3-17
MCL Serial 2 Recv Error, 3-17
MCL Serial 2 Send Error, 3-17
MCL Transmit Timeout, 3-17
MCL Tube Displaced Error, 3-17
MCL Tube Jam Error, 3-17
MCL Tube Load Error, 3-17
MCL Tube Position Error, 3-17
MCL Tube Up/Down Error, 3-17
MegaPanel cannot exceed 32 entries, 3-17
Memory unavailable, 3-17
messages

error, list of, 3-3
error, log, 3-2

Missing Protocol(s). Panel is not loaded., 3-18
mode

auto, routine cleaning, 1-21
idle, 1-4
manual, routine cleaning, 1-19

Must enter RBC or WBC to save Hematology 
info, 3-18

Must first select a histogram to redisplay, 3-18
Must first select a histogram to rescale, 3-18
Must RESTART after cyto adjust. Run aborted, 3-18
Must select panel to edit template!, 3-18

N
Must be greater than previous level, 3-18
Unable to save histogram, 3-33
, 3-18
Cannot be started --, 3-4
Cannot convert, 3-4
Do not have permission to, 3-7
in table, 3-15
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Invalid value for column, 3-15
Run time SQL error --, 3-24
to a, 3-4
Name must not consist entirely of spaces. 

DEFAULT is reserved, 3-18
Need a file name to save (Select ‘Save As’ for new 

file), 3-18
neutral density (ND1) filter

See filters, 2-20
No available counters, 3-18
No changes allowed while in Listmode, 3-18
No disk space on this device, 3-18
No histograms were noted, 3-18
No listmode results to display, 3-18
No more entries may be selected, 3-18
No more prism parameters can be assigned, 3-18
No more than 8 signals may be chosen as 

parameters., 3-18
No parameter selected, 3-19
No reports queue has been selected., 3-19
No template possible for Loadlist, 3-19
No valid baseline file, 3-19
No valid histogram files were found, 3-19
No valid histograms were noted, 3-19
No valid listmode files were found, 3-19
No valid protocol files were found, 3-19
No valid Specimen ID, 3-19
Not a valid region, 3-19
Not connected to SQL database, 3-19
Not enough memory to calculate amorphous 

statistics, 3-19
Not enough memory to start, 3-19
Not enough space for COPY, 3-20
Not enough space for MOVE, 3-20
Not enough space to add panel, 3-20
NOT found, 3-21
Not Yet Implemented, 3-20

O
or, 3-25
Only one more prism paramete can be 

assigned, 3-20
Operator ID

 is already assigned, 3-20
operator ID

assign on Maintenance screen, B-2
record on the Maintenance screen, B-2
supervisor, change the password, B-5

options

bar-code printer, how to connect, A-1
bar-code printer, switch settings, A-2
bar-code scanner/reader, how to connect, A-1

Out of MEMORY printing cytosettings, 3-20
Out of range, 3-20

0 - 9,999,999, 3-20

P
Panel contains deleted protocols or Error accessing 

panel file., 3-20
Restarting MCL because

Num of protocols, 3-24
Panel has auto setup protocols, 3-20
Panel has been modified since last MCL run, 3-20
Failure to resume panel

, 3-12
Invalid Loadlist Attributes changed in, 3-14
Invalid Loadlist Error accessing panel, 3-14
Invalid Loadlist Error opening panel, 3-14
Invalid Loadlist Panel size changed in, 3-15
Invalid Loadlist Protocol changed in, 3-15
Panel

, 3-21
Panel needs to be saved first, 3-21
Panel not copied., 3-17
Panel was edited, save before exiting, 3-21
Parameters are not present, 3-21
Parameters are not present, Carousel aborted on 

tube #, 3-21
Password was changed, 3-21
password, supervisor

how to change, B-5
Patient ID minimum of 5 characters, 3-21
positioning neutral density (ND1) filter, 2-20
Possible full disk, 3-12, 3-21
pressure

system, adjusting, 2-18
Printer

bar-code, connection, A-1
bar-code, switch settings, A-2

Printer busy, 3-21
Printer error, 3-21
PRINTER NOT READY!, 3-22
Printer out of paper, 3-22
Prism parameters coexist. Dividers set to lower 

letter regions, 3-22
probe, sample

cleaning, 1-22, 1-23
procedures
PN 4237296CA INDEX-5



INDEX
adjustment. See adjustment procedures, 2-1
cleaning. See cleaning procedures, 1-1
replacement. See replacement procedures, 2-1

Failure to resume Protocol
, 3-12

Unable to access file, 3-30
Protocol not valid, 3-22

Q
QC Lot# could not be read from, 3-22
QC Maintenance screen

editing, B-2
working with, B-1

Quadstat regions not allowed in this equation, 3-22

R
RAM memory is full, 3-22
Read Cyto State timeout, 3-23
reader, hand held

See bar-code scanner/reader, A-1
reagent containers

about, 2-1
removing, 1-5

reagent drawer
location, 1-5, 2-1

reagents
containers, fill level, 2-8
containers, replacing, 2-1
replacing, 2-1

Seek error, 3-25
Rectilinear regions not allowed in prism 

equation, 3-23
reference manual

conventions used,  x
introduction to your manuals,  x
using the manuals,  x

Region already erased, 3-23
Region does not exist, 3-23
Region undefined. May only edit defined 

regions., 3-23
Region with PRISM, TIME, AUX not allowed in 

prism, 3-23
REMOVED, 3-13
removing

reagent containers, 1-5
replacement procedures, 2-1

cleaning agent, 2-7
reagent containers, 1-11, 2-1

record on Maintenance screen, B-1
sample head, 2-15
sheath filter, 2-13
sheath fluid, 2-2

Replay Not Active, 3-23
Replaying Data For Listmode Files Saved, 3-23
Requested file does not exist in this directory, 3-23
residual stain

testing for, 1-22
Restarting MCL because

Did not find panel in current directory, 3-23
MCL/ Panel protocol mismatch at entry, 3-24
MCL/Panel attribute mismatch at entry, 3-23
MCL/Panel panel name mismatch at entry, 3-24

Restarting MCL because Failed to access carousel 
file (entry 33), 3-23

Restarting MCL because Failed to access carousel 
file (entry), 3-23

S
sample head

cleaning, 1-22, 1-23
replacing, 2-15

Sample Pressure Error, 3-24
Sample Pressure Okay, 3-24
Sample pressure warning, 3-24
sample probe

cleaning, 1-22, 1-23
Sample Stage Error, 3-24
Sample Tube Error, 3-24
sampling system

when to clean, 1-18
scanner, hand held

See bar-code scanner/reader, A-1
Selected panel not loaded into memory, 3-25
Selected Region is not in specified histogram, 3-25
Selected signal cannot be a CALCULATED 

parameter, 3-25
Selected signal must be a parameter, 3-25
Selection or erase of signals not allowed under 

listmode, 3-25
Selection, edit or erase of ratio not allowed under 

listmode, 3-25
Sensor data stream error, 3-25
Sensors Stream Warning, 3-25
Server/database engine version mismatch, 3-25
Set Idle Mode Cmd timeout, 3-25
Set sample pressure fail, 3-25
sheath container
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cleaning, 1-7
fillling, 2-2

Sheath Drawer Error, 3-25
Sheath Drawer Okay, 3-25
Sheath Drawer Warning, 3-25
sheath filter

replacing, 2-13
sheath fluid

container, cleaning, 1-7
replacing, 2-2
use in routine cleaning, 1-19, 1-21

Sheath Level Error, 3-25
SHEATH LEVEL LOW! Add fluid. When cyto is 

READY, press, 3-26
Sheath Level Okay, 3-26
Sheath Level Warning, 3-26
sheath low indicator, 3-1

what to do when red, 3-1
Sheath Pressure Error, 3-26
Sheath Pressure Okay, 3-26
Sheath Pressure Warning, 3-26
Signal is already not used as a parameter, 3-26
Signal is already used as a parameter, 3-26
Skipping a queued file due to error, 3-26
Software Failure, 3-26
special procedures and troubleshooting manual

icons, description,  x
information organization,  ix
symbols, meaning,  x
using the manual,  ix

Specified database is invalid, 3-26
Specified database not found, 3-26
Specimen ID change NOT allowed, 3-27
stain, residual

testing for, 1-22
State Machine Failure, 3-27
Statement interrupted by user, 3-27
String must be NUMERIC if longer than 8 

characters, 3-27
supervisor password

how to change, B-5
symbols used in the manual,  x
system pressure

adjusting, 2-18
System Pressure Error, 3-27
System Pressure Okay, 3-27
System Pressure Warning, 3-27
System Vacuum Error, 3-27
System Vacuum Okay, 3-28

T
TARGET HISTOGRAM INCOMPATIBLE, 3-28
TARGET HISTOGRAM MUST BE 

DIFFERENT, 3-28
Temperature Error, 3-28
Temperature Okay, 3-28
Temperature Sensor Failure, 3-28
Temperature Warning, 3-28
TERMINAL ERROR IN System! Press the Enter key 

to exit program, 3-28
Terminated by user -- transaction rolled back, 3-28
There are no saved key strokes to write to disk, 3-28
There are still active database connections, 3-28
There is no acquisition data to print, 3-28
There is presently no panel file to process, 3-28
This report requires that COLOR be ON for your 

printer, 3-28
To cont. MCL wait for msg -Insert Sample Tube-, 

press AUTO, 3-29
To use ‘Save As’ a protocol must be loaded, 3-29
To use ‘Save’ a protocol must be loaded, 3-29
Too many connections to database, 3-29
Too many prism parameters entered, 3-29
Too many Protocols in Panel, 3-29
Too many regions used for gating, 3-29
Transmit time-out, 3-29
Transputer 1 error, 3-29
Transputer 2 error, 3-29
Transputer Link Error, 3-29
Transputer Link Failure, 3-29
Transputer Link Okay, 3-29
troubleshooting, 3-1

error message log, 3-2
error messages, 3-3
level sense indicators, 3-1

Tube ID already assigned, 3-29
Tube ID does not match barcode. MCL will be 

stopped., 3-30
Fail to close Listmode file, Carousel aborted on 

tube#, 3-12
Error in writing file, Carousel aborted on tube 

#, 3-10

U
Unable to access file., 3-30
Unable to activate mouse, 3-30
Unable to allocate memory, 3-30
Unable to allocate protocol memory, 3-30
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Unable to assign histogram memory, 3-30
Unable to autogate, 3-30
Unable to change histogram display, 3-30
Unable to create the histogram queue, 3-31
Unable to create the regions display, 3-31
Unable to find the Listmode file, 3-31
Unable to find the Listmode file, Carousel aborted 

on tube #, 3-31
Unable to find the Listmode file, Current operation 

aborted, 3-31
Unable to find the panel info, 3-31
Unable to find/open the protocol file, 3-31
Unable to get the available disk space, 3-31
Unable to get the specified Cytometer state, 3-31
Unable to initialize histogram memory, 3-31
Unable to initialize protocol memory, 3-31
Unable to load current panel, 3-31
Unable to load hematology info from database, 3-32
UNABLE TO LOAD LISTMODE FILE, 3-32
Unable to load panel, 3-32
Unable to load patient info from database, 3-32
Unable to load QC Template file related to this 

protocol, 3-32
Unable to load queue file, 3-32
Unable to load specimen info from database, 3-32
Unable to load this protocol version, 3-32
Unable to open current panel, 3-32
Unable to open file, 3-32
Unable to open file for processing, 3-32
Unable to open Listmode work file, 3-32
Unable to open matching QCS file, 3-32
Unable to open Panel file, 3-32
Unable to open QCC (or QCS) file, 3-32
Unable to open template file, 3-33
Unable to print with no histograms, 3-33
Unable to Process, 3-33
Unable to read file, 3-33
Unable to read header, 3-33
Unable to read non-XL protocols, 3-33
Unable to reset Cytometer--reboot, 3-33
Unable to save - Protocol not loaded, 3-33
Unable to save protocol file, 3-33
Unable to save protocol file Carousel aborted on 

tube #, 3-33
Unable to save protocol file Current operation 

aborted, 3-34
Unable to save protocol with no histograms, 3-34
Unable to save template, 3-34
Unable to set Cytometer in the READY to ACQUIRE 

state, 3-34
Unable to start database engine, 3-34
Unable to start specified database, 3-34
Unable to write PCX file, 3-34
Unknown data stream error, 3-34
Unknown data stream warning, 3-34
Unknown error, 3-34
Unknown file type, 3-34
Unknown region type. Call for service., 3-34
Unknown Stream Warning, 3-34

V
Vacuum Chamber Error, 3-34
Vacuum Chamber Warning, 3-34
vacuum line

cleaning, 1-24, 1-25
vacuum trap

cleaning, 1-12
Valid display angle range is 0 to 360, 3-34
Values allowed

, 3-34
VDI display device driver not loaded properly., 3-35
vent button

function, 2-5
location, 2-5

vent port
location, 2-5

W
Warning

Less than 1 megabyte of disk space 
available, 3-35

Less than 4 megabytes of disk space 
available, 3-35

No valid histograms were noted, 3-35
No valid signals were noted, 3-35

Waste Backpressure Error, 3-35
Waste Backpressure Okay, 3-35
waste container

emptying, 2-10
location, 2-10

waste full indicator
what to do when red, 3-1

Waste Level Error, 3-35
WASTE LEVEL FULL! Empty tank. When cyto is 

READY, press RUN, 3-35
Waste Level Okay, 3-35
Waste Level Warning, 3-35
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Worklist file not found, 3-35
Worklist type panel may not be edited, 3-35
Wrong Date format or out of range, 3-36
Wrong file, 3-36
Wrong password, 3-36
Wrong Time format or out of range, 3-36

X
X and y channel count exceeded 65535, 3-36
X channel count exceeded 65535, 3-36
XL/XL-MCL system

installation, 2-1
manuals, hard-copy,  ix

Y
Y channel count exceeded 65535, 3-36
You cannot delete the next use entry, 3-36
You cannot deselect the next use entry, 3-36
You may not make a deleted or errored entry as 

next, 3-36
You must select a protocol., 3-36

Z
Zero length file, 3-36
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